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Preface

This document describes the features and changes included in the Oracle Hospitality
Simphony version 2.7 Maintenance Release (MR) 6.

Audience

This document is intended for all users of Oracle Hospitality Simphony version 2.7 MR6.

Documentation

Oracle Hospitality product documentation is available on the Oracle Help Center at
http://docs.oracle.com.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:
e Product version and program/module name
e Functional and technical description of the problem (include business impact)
o Detailed step-by-step instructions to re-create
e Exact error message received and all associated log files that reflect the error
e Screen shots of each step you take

Revision History

Date Description of Change
July 2015 e Initial publication
July 2015 e Updated publication for Oracle MICROS Tablet E-

Series platform information and connectivity.

May 2017 e Added details for the support of the Oracle
MICROS Tablet 720 with Microsoft Windows 8.1

June 2017 e Updated the Known Issues section
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1 Features and Updates

This section describes the new features and enhancements included in this release.

Licensing

Support for entering license counts

A new License Configuration tab is available in the Enterprise Parameters module for you
to enter the number of licenses that you purchased for:

o Workstation clients
e KDS clients
¢ Engagement clients
e Transaction Services clients
In addition to entering the license count, you can:
e Append new purchases to existing license counts.

e Compare the number of licenses purchased with the number of clients configured
side by side.

e See an overview of property, revenue center, workstation, KDS, Engagement,
and Transaction Services client configurations.

License Counts in the Simphony 2.7 documentation library provides more information.

Workstations and Tablets

Support for Oracle MICROS E-Series Base Station

Simphony now supports the Oracle MICROS E-Series Base Station. You can attach
(dock) the Oracle MICROS Tablet E-Series 11-inch model (connected to the sleeve with
the magnetic card reader) to the Base Station.

The Tablet E-Series must use platform version 1.4 to connect to the Base Station. The
Upgrading Oracle MICROS Tablet E-Series section in this document provides more
information.

You can use the following peripheral devices connected to the Base Station with the
Tablet E-Series while the tablet is docked:

e Barcode Scanner

e Cash Drawer

e Coin Changer

e Customer Display — Pole Display 2x20 and LCD Pole Display 240x64

e Printers — Bluetooth, Intelligent Device Network (IDN), Internet Protocol (IP), and
Serial

e Serial Scale
e Sales Recording Module (SRM)

When you remove the Tablet E-Series from the Base Station, connectivity to the
peripheral devices is severed. When the Tablet E-Series is docked in the Base Station,
connection is restored to the peripheral devices.

You can now use Enterprise Cash Management (ECM) on the Tablet E-Series 11-inch
and Base Station.

Features and Updates 1-1
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Support for Oracle MICROS Tablet 720
Simphony now supports the Oracle MICROS Tablet 720 with Microsoft Windows 8.1.

The Oracle MICROS Tablet 720 comes with a built-in OPOS Barcode Scanner and a
built-in OPOS Mag Stripe Reader (MSR).

To configure the barcode scanner:

1.

ok wbd

In EMC, select Property, Setup, Hardware/Interfaces, Workstations, and
then Devices.

In the Peripheral Device Configuration section, click Add.

For Select Peripheral Device Type, select OPOS Barcode Reader.
For Configuration, enter Honeywell.

Click OK, and then Save.

To configure the MSR:

1.

o kv

In EMC, select Property, Setup, Hardware/Interfaces, Workstations, and
then Devices.

In the Peripheral Device Configuration section, click Add.

For Select Peripheral Device Type, select OPOS Mag Stripe Reader.
For Configuration, enter IDTECH SECUREMAG USBHID.

Click OK, and then Save.

The Oracle MICROS Tablet 720 Setup Guide contains more information on setting up
and using the Tablet 720.

Features and Updates



2 System Requirements, Supported
Systems, and Compatibility

This section describes the supported enterprise server operating systems, databases,
and devices by Simphony version 2.7 MRG6.

Supported Enterprise Server Technology

Simphony supports the following operating system:
e Microsoft Windows Server 2008 R2
Simphony supports the following databases:
e Oracle Database 11g
¢ Microsoft SQL Server 2008 R2

Supported Handheld Devices
¢ Motorola MC40 (Microsoft Windows Embedded version 7.0)
e DT Research DT365 tablet (POSReady 7)

Supported Tablets and Workstation Devices
Oracle MICROS Tablet 720 (Microsoft Windows 8.1)
e Oracle MICROS PC Workstation 2015
e Oracle MICROS Tablet E-Series 8-inch and 11-inch models

o Operating system image v1.4 or later is required for Oracle MICROS E-
Series Base Station support. See the Upgrading Oracle MICROS Tablet E-
Series section for more information.

o Configure the tablet to use either the wired or wireless connection.

e Use a wired connection if you do not intend to remove the tablet from the
base station, as doing so will disconnect you.

e Use a wireless connection if you intend to remove the tablet from the
stand, as doing so will not disconnect you.

e The Oracle MICROS Tablet E-Series does not support switching from
wired to wireless network connections and vice versa.

e Oracle MICROS Workstation 6

¢ Oracle MICROS Workstation 5A (POSReady 2009)
e Android 4.4 (KitKat) tablets

e Apple iPad Air 2, 3, and 4 models

Supported Peripheral Devices
e Barcode Scanners

o Motorola - LS9208, LS2208, DS9208, and DS2208 models
o Sleeve for Oracle MICROS Tablet E-Series 8-inch
o Sleeve for Oracle MICROS Tablet E-Series 11-inch

e (Cash Drawers

System Requirements, Supported Systems, and Compatibility 2-1
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Coin Changer — Telequip T-Flex

Customer Display(s) — Rear base 240x64 and 2x20 LCD display units
Receipt Printers

o Bluetooth

o Ethernet — Epson TM-88 (ll, IlI, 1V, V), and TM-U220B models

o Intelligent Device Network (IDN) — Epson TM-88 (ll, Ill, IV, V), and TM-
U220B models

Serial Printers (RS232)
o Epson TM-88 (lI, IlI, 1V, V), TM-U220B, and TM-U295 models
o Slip printer
Magnetic Stripe Readers (MSR)
Oracle MICROS workstation integrated MSRs
MagTek DynaPro Audio Jack Reader
MagTek DynaPro Mini Card Reader
Sleeve for Oracle MICROS Tablet E-Series 8-inch
Sleeve for Oracle MICROS Tablet E-Series 11-inch
MSR for iPad devices

= MagTek iDynamo
o MSR for Android devices

= MagTek uDynamo

O O O O O O

Serial Scales — Mettler-Toledo Viva and Ariva models

System Requirements, Supported Systems, and Compatibility



3 Installation and Upgrade

In order to upgrade to Simphony version 2.7 MR6, you must have version 2.7 General
Release (GR) or later installed. You can upgrade to 2.7 MR6 from versions 2.7 GR
through 2.7 MRS (including Hot Fixes). You cannot perform an upgrade to 2.7 MR6 from
any version earlier than 2.7.

e If you are upgrading from a version earlier than 2.7, install version 2.7 GR and
then install version 2.7 MR6. Do not deploy the version 2.7 GR client packages to
the properties before upgrading to 2.7 MR6.

e If you are staging a new system, install version 2.7 GR and then upgrade the
system to 2.7 MRG6.

Download the installation file Simphony_2.7_MR6.iso from
http://downloads.micros.com/micros/simphony/Simphony 2.7 MR®6.iso

Upgrading Oracle MICROS Tablet E-Series

The Oracle MICROS Tablet E-Series must be running operating system image version
1.4 or later to use the Oracle MICROS E-Series Base Station. Confirm the image version
in the Microsoft Windows Control Panel.

If the image is earlier than version 1.4:

1. Download the updated image from
http://members.micros.com/members/product_support/hardware/corporate/2010Il
magesftp/Default.aspx?frmCD=/images/mTablet%20E-Series/11in.

2. Install the updated image using the image recovery process.

Installation and Upgrade 3-1
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Resolved Issues

4 Resolved Issues

Table 1 shows a list of issues that have been fixed since the last release.

Table 1 — Resolved Issues

Module

CRID

TP ID

Description

Credit Card Batch
Process

36484

98269

If a VISAD credit card batch reaches the
Max Batch Record threshold during
settlement, then new batches are now
created until all credit card records are
settled.

Data Transfer Service
(DTS)

36327

94659

All journal records now post to Reporting
and Analytics Advanced (formerly called
mymicros.net) on Oracle environments.

Direct Posting Service
(DPS)

34317

31316

Major group and family group masters of
menu items defined at the property level now
post to Reporting and Analytics Advanced.

DPS

N/A

99616

The DPS now truncates reference entries
that have more than 40 characters.
Additionally, the maximum length of a
reference entry that you can enter in Ops is
now limited to 40 characters.

DPS

36242

93195

The Direct Posting Service (DPS) no longer
posts the service charges on team service
checks twice.

EMC

32363

10515

You can no longer modify the Print Classes
records inherited from the enterprise level
from lower levels.

EMC

33265

18778

You can no longer delete operator records of
employees that were created in Labor
Management from Employee Maintenance
using the Delete key.

EMC

34822

8427

Employee Maintenance now filters the
results according to your search criteria
when you search for employees by first and
last name using the All Languages filter.
Additionally, the All Languages filter no
longer disappears when you refresh the data
in the module.

EMC

35781

95323

Employees with only the view privilege can
no longer make changes to the CAL
Packages module.

EMC

36108

88948

You can now configure and save a
workstation record as a POSAPI Client with
the language set to a language other than
English.

EMC

N/A

96971

You can use the Workstation Type 6 -
MICROS Tablet Client to configure the
Oracle MICROS Tablet E-Series in the
Workstations module. The Oracle MICROS
Tablet R-Series is no longer supported.
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Module

CRID

TP ID

Description

Ops

32724

96056

After performing a database update, you can
now successfully log in to new revenue
centers that were assigned to the
workstation while the service host was
running.

Ops

33883

95356

Inclusive tax and discounts now calculate
accurately when you change the order type
of a check.

Ops

36084

88263

On Windows 32 workstations, System
Interface Module (SIM) input dialog boxes
now appear in the resolution defined in the
SIM script.

Ops

32978

16270

When a workstation operator applies
percentage discounts and services charges
to qualified menu items on a check, the
percentage value of the discount or services
charge now shows in the check detail area
as well as on printed guest checks and
customer receipts.

Ops

35794

77627

You can now scan or manually enter
barcodes that begin with a non-zero number
regardless of the format index.

Ops

36246

96236

You can now print receipts for orders
created using Transaction Services.

Ops

36322

96281

An error message now shows if you enter an
incorrect PIN when attempting to change the
price of a menu item through the
workstation.

Ops

36336

97429

Menu item prices, subtotal, tax, and total due
now convert correctly according to the
current conversion rate from Canadian dollar
to US dollar.

Ops

36351

95099

Ops now recognizes overridden extension
application content records.

Ops

36365

95203

If a discount itemizer only applies to a
condiment, then the condiment is now
discounted.

Ops

N/A

94692

The Oracle MICROS Workstation 6 no
longer skips the second dialog box when two
or more dialog boxes appear one after the
other.

Ops

N/A

96077

When multiple revenue centers are assigned
to the same workstation, Ops now sends the
TermID of the revenue center that you are
currently logged in to during credit card
authorization when using the Fusebox
payment driver.

Ops

N/A

98761

Performance of the Oracle MICROS Tablet
E-Series device (formerly called mTablet E-
Series) is improved with this release.
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Module

CRID

TP ID

Description

Ops

N/A

99261

Authorizing a credit card (CC) using an
Oracle MICROS Tablet E-Series with a
sleeve by swiping the CC on the magnetic
stripe reader (MSR) no longer fails.

Printing

36031

86356

When you individually enter multiple
quantities of a menu item (without using the
@Ifor key) that is linked to more than one
tax rate, the workstation now rounds the tax
totals correctly.

Printing

36221

92727

The Epson TM-U220 (RS-232) now prints
the price in line with the menu items.

Printing

36522

99945

Orders are now sent to the backup printer
only when there is a failure with the primary
Kitchen Display System (KDS) in a non-
Dynamic Order Mode (DOM) environment.

Taxes

36532

96990

Tax exemptions now remain on the check
even when the workstation operator
performs multiple service totals on the
check.

Transaction Services

N/A

96771

The Get Open Checks function key now
returns the revenue center object number.

Workstation Reports

35686

74269

When multiple employee’s link to the same
cashier record and a linked employee
reopens a check and makes changes, the
workstation financial report now reflects the
changes.

Workstation Reports

36068

87658

If you select a shift for generating the
workstation Employee Financial — VAT
Report, then the report now only shows the
totals for the selected shift.

Workstation Reports

36112

89024

Workstation Financial Reports now calculate
the Net Sales accurately when you split a
check containing a menu item with a priced
condiment and an inclusive tax.

Workstation Reports

36344

94981

When you adjust the charge tip of a
reopened team service check, now only the
new charge tip posts and it is distributed
equally amongst the team members.
Additionally, the workstation Financial
Report now tracks voided charge tips.

Resolved Issues

4-3



Known Issues

Table 2 shows a list of known issues.

Table 2 — Known Issues

5 Known Issues

Module CRID TP ID Description

Enterprise Cash N/A 97604 When a workstation operator undocks and

Management redocks the Oracle MICROS Tablet E-
Series device into a different Base Station,
the Till Report reflects the Oracle MICROS
Tablet E-Series device that was used
during the till opening.

Hardware N/A 147892 Oracle MICROS 720 tablets, running

Microsoft Windows 8.1, fail to print to TM-
P80 OPOS USB connected printers
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Preface

This document describes the features and changes included in the Oracle Hospitality
Simphony version 2.7 Maintenance Release (MR) 5.

Audience

This document is intended for all users of Oracle Hospitality Simphony version 2.7 MR5.

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https:/ /support.oracle.com

When contacting Customer Support, please provide the following;:

Product version and program/module name

Functional and technical description of the problem (include business impact)
Detailed step-by-step instructions to re-create

Exact error message received

Screen shots of each step you take


https://support.oracle.com/

Features and updates

This section describes the new features and enhancements included in this release.

Improved effectivity performance
CR ID#: N/A
TP ID#: 92658

Effectivity processing in Ops is now optimized on all operating systems and database
types. Effectivity processing runs:

=  On POS startup.
=  Twice after a database reload.

=  After an update which can affect a database record with effectivity (for example,
menu item price, tax, discount, tender media, service charge, or combo group detail
price).

You can see effectivity diagnostics within Ops in the Property Management Console

(PMO):

1. Click the Support tab, select State, and then select DataStore.

2. You can select the new Effectivity History and Effectivity Detail tabs.
= Effectivity History shows summaries of the ten most recent effectivity updates.

=  Effectivity Detail shows all change records associated with effectivity and
indicates active database records.

Added support to apply discounts using condiments
CR ID#: N/A
TP ID#: 92889, 92890, 92891

You can now apply manual, automatic, and coupon discounts to a check when a
condiment item is present on the check. A workstation operator can manually apply a
discount by selecting the condiment item. You can place condiments in trigger menu
item groups to have the system apply automatic and coupon discounts.

Related Links: Applying Discounts Using Condiments

Added support to hide Employee PIN
CR ID#: 36244
TP ID#: 93551

The Employee PIN is now masked in the PMC Edit Employee PIN dialog. While the user
is editing or viewing an Employee PIN, the asterisk sign (*) appears in the Employee PIN
field.



System requirements

Simphony version 2.7 MR5 is compatible with the following platforms:

Category Supported Products
Operating System =  Microsoft Windows Server 2008 R2
Databases =  Oracle Database 11g

= Microsoft SQL Server 2008 R2




Installation and upgrade

Download the installation file Simphony_2.7_MR5.iso from
http:/ /downloads.micros.com/micros/simphony/Simphony_2.7_MRb5.iso.
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Resolved

Issues

The following is a list of issues that have been fixed since the last release.

Module

CRID

TP ID

Description

Data Transfer Service
(DTS)

N/A

92556

The Data Transfer Service (DTS) now
updates newly created properties with the
records modified at the zone level.

Direct Posting Service
(DPS)

N/A

94193

The Direct Posting Service (DPS) no longer
fails when the workstation posts checks
with large prices.

Enterprise Management
Console (EMC)

N/A

92445

The context-sensitive help for the Printer
Configuration Address field in the Printers
module now describes the configuration for
banquet checks.

Extensibility

N/A

92817

Extensibility now retrieves team member
details of team service checks.

Install

N/A

92922

SIMPURGE is now turned on by default
with a 30 minute interval for Simphony
fresh installations and upgrades.

Journals

N/A

92450

The following changes were made to the
check journal:

=  Removed the check number from the
check journal header and replaced it
with the workstation number.

= The line TRN XXX/YYY, where XXX is
the workstation number and YYY is the
transaction number now always prints
on the check journal header.

=  When you select options [55 - Print
Workstation Number] and [56 - Print
Transaction Number], the transaction
number and workstation number are
written below the header in the final
check image in the journal.

Kitchen Display System
(KDS)

36203

92085

Speed of Service (SOS) displays now restart
only when you make a change to the KDS
Controller.

Kitchen Display System
(KDS)

N/A

92618

The KDS Controller no longer uses the
Property Parameter’s Database Update
Frequency when you define the KDS
Controller’s Database Update Frequency.




Module

CRID

TP ID

Description

Ops

31762

92448

Reprint Closed Check from List now shows
checks in reverse chronological order
according to the check close time.

Ops

33787

92465

Employee meal tenders now prompt for the
employee.

Ops

34615

92466

When you select RVC Parameters option [53
- Use Revenue Center Check Numbers],
check numbers now increment only when
an operator uses [Begin Check by Name] to
successfully create a check.

Ops

35057

92467

You can now assign an employee ID or
magnetic card only for employees
belonging to the same employee level and

group.

Ops

35986

93215

The automatic service charge now
recalculates according to the discounted
subtotal when you select option [11 -
Affects Auto Service Charge (Only
Subtotal Discounts)] and an operator adds
an automatic discount to the check.

Ops

36111

94073

Revenue center order device IDs no longer
have to be in sequence for the PMC to
redirect order devices accurately.

Ops

36243

93498

You no longer see an error message after
swiping a stored value card for a partner
discount.

Ops

36245

93563

When the parent menu item count exceeds
one, the check detail area no longer shows
all default condiments when the operator
reopens a saved check.

Ops

36266

94123

You can now change the food zone of a
property without getting an error.

Ops

N/A

92179

All automatic discount types now support
combo meals. Additionally, the following
changes were made:

= If an item price substitution discount is
configured for a combo meal group and
you select option [25-Discount Combo
Meal Group Items], the discount is
now applied to all items in the combo
meal.

= If a quantity threshold discount is
configured for a combo meal, it no
longer affects the behavior of other
automatic discounts configured for that
combo meal.

Ops

N/A

92438

Changing serving service periods no longer
removes taxes from the guest check.




Module

CRID

TP ID

Description

Ops

N/A

92439

When you select Control Parameter option
[6- Confirmation Required for Touch-
Void], the workstation now prompts for
confirmation when an operator performs a
touch-void.

Ops

N/A

92443

Operators can no longer suspend guest
checks when you deselect RVC Parameters
option [60 - Enable Suspend/Resume].

Ops

N/A

92446

Windows CE workstations no longer freeze
when attempting to print a report while in
the Display tab. You now see an error
message informing that this operation is no
longer allowed.

Ops

N/A

92447

The Condiment Orderer on Windows 32
workstations now highlights the correct
condiment group title.

Ops

N/A

92490

Names of discounts, service charges, and
tenders now show in list box Screen Look
Ups (SLU) on Android and iOS
workstations.

Ops

N/A

93468

Automatic discounts that come into effect
after a menu level ends are now applied
only to new items added to split checks and
not to items that were rung in during the
previous menu level.

PMS

3623

93502

You can now apply room charges to checks
when using Enhanced PMS with the
Quebec Sales Recording Module.

Ops

N/A

93516

Ops no longer shows an error and prevents
you from starting a check on a workstation
with no cash drawers when cash
management is configured.

Ops

N/A

93616

The system now accurately calculates
automatic discounts when you configure
multiple amount discounts.

Ops

N/A

93712

Open percent service charges now post to
Charged Tips and Tips Paid in the
Employee Tip Report.

Ops

N/A

94104

Tax rates with multiple effective time
frames now post accurately to checks and
expire after all effective time frames defined
in Effectivity Groups elapse.

Ops

N/A

94105

Effectivity now works on Android and iOS
workstations for menu items, service
charges, discounts, tax rates, tenders, and
Ppage content.




Known

Module

CRID

TP ID

Description

Ops

N/A

94125

Taxes now post to checks when you move
the property to a new tax zone.

Ops

N/A

94132

You no longer have to restart Ops for
employee PIN changes made through the
Property Management Console to take
effect.

PMS

36294

94324

When you void a room charge from a
reopened close check or an adjust closed
check, that room charge is now removed
from the guest’s folio.

Printing

N/A

92668

You must select [Print Plain Text] in the
Printers module if you do not want to print
line breaks on checks printed by OPOS
printers attached to Mettler Toledo VCO
Scale workstations. This option is deselected
by default.

Transaction Services

N/A

77752

The [Get Open Checks] function key now
returns the revenue center object number.

Transaction Services

N/A

92444

Transaction services now exempts all tax
rates when an operator applies a tax exempt
service total to a check.

Transaction Services

N/A

92489

If a check is being manipulated on the
Transaction Services client, you can no
longer open or edit that check from a
workstation. Conversely, you cannot pick
up checks open at the workstation from a
Transaction Services client.

Transaction Services

N/A

92491

The [Calculate Totals] function key now
returns the object numbers, prices, and the
menu levels of the selected items on a
check.

Transaction Services

N/A

93504

When you select option [38 - Enable Sales
Recording Module], the point-of-sale (POS)
no longer fails to close checks that were
settled using the PIN pad.

Transaction Services

N/A

93601

The count of a menu item rung in at the
workstation now updates when that menu
item is added to the same check using
Transaction Services.

There were no new issues reported during the testing of this version.
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Release overview

The Simphony 2.7 MR4 Release Notes describe new features and enhancements for this version of Simphony.
Features and updates

Engagement

Added backward compatibility for Engagement widgets
CR ID#: N/A
TP ID#: 78616
Backward compatibility for Engagement widgets has been added. This includes the following:

= New and existing widgets are configurable and compatible to share the same page while running on older
workstations.

= |f a new widget is not supported on an older Service Host version, an Upgrade Service Host Version to
Support New Widget message appears that contains the required version information for compatibility.


http://wiki.micros.com/wiki/index.php?title=Simphony_2.7
http://wiki.micros.com/wiki/index.php?title=Simphony_2.7_Maintenance_Release_1
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All Engagement versions support Simphony version 2.7 (or higher).
Related Links: Engagement 1.2 Release Notes, Engagement Feature

Engagement Welcome and Hub page languages are translatable
CR ID#: N/A
TP ID#: 78624
When Engagement users access either a Welcome or Hub page, the pages are now translatable based on the hierarchy
described here. Listed in order of highest to lowest priority levels, Hub pages will be translated using the first
available translation:

1. Current Ops client language (Highest priority level) - Page language translation occurs based on the current
language that the Ops client is utilizing and is being viewed that time.

2. Employee's default language - Page language translation occurs based on the employee's default language as
configured in the Simphony EMC, Enterprise, Configuration tab, Personnel, Employee Maintenance, Operator
record, General tab, Language field.

3. Workstation's default language - Page language translation occurs based on the default language assigned to the
workstation from the Simphony EMC, Property level, Hardware/Interfaces, Workstations module, General tab,
Language field setting.

4. System’s default language (Lowest priority level) - Page language translation occurs based on the first record listed
(which is always US-English and cannot be changed) in the Simphony EMC, Enterprise level, Enterprise
Information, Languages module.

Listed in order of highest to lowest priority levels, Welcome pages are translated using the first available translation:

1. Workstation's default language - Page language translation occurs based on the default language assigned to the
workstation from the Simphony EMC, Property level, Hardware/Interfaces, Workstations module, General tab,
Language field setting.

2. System's default language (Lowest priority level) - Page language translation occurs based on the first record listed
(which is always US-English and cannot be changed) in the Simphony EMC, Enterprise level, Enterprise
Information, Languages module.

For those instances whereby widgets are translating (and showing) differing languages, the same hierarchy as described
previously applies. For example, if a Daily Specials Widget has a Chinese translation, but an Image Widget does not, the
Daily Specials Widget would show Chinese and the Image Widget would default to the next available language, even
though they are appearing on the same page. This scenario is consistent with Ops behavior when a translation does not exist
for a specific field or item.

Related Links: Engagement 1.2 Release Notes, Engagement Feature, How to configure language translation for Engagement

Hardware

Added support for mTablet R-Series to run on Android mobile operating system
CR ID#: N/A
TP ID#: 88481
The mTablet R-Series can now run on the Android mobile operating system.

Related Links: Simphony Android Configuration

Ops

Added Popup Condiment Orderer for required condiments
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CR ID#: N/A

TP ID#: 88203

The new Popup Condiment Orderer template streamlines the configuration and ordering process for menu items with
required condiments. You can create the Popup Condiment Orderer pages in EMC using the template and configure
the popup to appear for the revenue center or menu item class. When the operator adds a menu item with required
condiments to the transaction, the Popup Condiment Orderer appears automatically for condiment selection. You can
configure the Popup Condiment Orderer to edit a previously ordered menu item with required condiments.

Related Links: Popup Condiment Orderer

Workstations
Added support for mWorkstation or Workstation 610

CR ID#: N/A

TP ID#: 79321

You can now use the mWorkstation or Workstation 610 with Simphony version 2.7 MR4. This workstation runs on
the Microsoft Windows Embedded 8.1 Industry operating system and supports the following services:

= Check and Posting Service (CAPS)
Service Host

Print Controller

KDS Controller

Backup KDS Controller

Related Links: Workstation Comparison Chart, Known issue

System requirements

Simphony version 2.7 MR4 is compatible with the following platforms:

Category Supported Products
Operating ) )
System Microsoft Windows Server 2008 R2

Oracle Database 11g, Microsoft SQL Server 2008

Databases R?

Related Links: Simphony 2.x Platform Capabilities Matrix
(http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/Simphony_v2_Platform_Capabilities_Matrix.xIsx)
, System Security Enhancements
(http://mww.micros.com/ServicesAndSupport/InformationSecurity/OperatingSystemSecurityEnhancements/Operating)

Installation and upgrade

Download the installation file Simphony_2.7_MRA4.iso from
http://downloads.micros.com/micros/simphony/Simphony_2.7_MRA4.iso.
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Issues

Resolved

The following is a list of issues that have been fixed since the last release.

CR TP —
Module D ID Description

CAL N/A | 89400 To prevent mStation or mWorkstation devices from going into hibernate or sleep modes,
delete the MICROS power plan and perform a Client Application Loader (CAL) operation.

Credit Card The Shift4 Dollars On The Net credit card payment driver no longer settles payments with

: 36140| 89881 .. .

Driver tips as refunds when you discount a check 100 percent.

Database 36078 87224 I\\(/I?Quzno longer see an error when upgrading an Oracle database from Simphony version 2.7

DPS 35959 86653 The Reprmt_ Qlosed Check function now increments the number of checks printed in the
location activity database.

All transactions carried out after midnight now post to the Reporting database with the

DPS N/A | 86208| current business date until you increment the business date when manually running Start of
Day.

EMC 34467| 86651 The Event Schedules modul_e now recognizes Run Script as a valid event type, and the
scheduled scripts execute without error.

The following Property Summary options are active when you activate mylabor for a
property:
= 4 - International LDS Posting without a Table Number Starts an LDS Fast
EMC 35982| 84001 Transaction
= 5 - Match Employee Entries in International LDS Suspense File with Other
Employees
= 9 - Disable Workstation Online Prompt
Operators without the role privilege [30055 - Assign Employee Fingerprint Scan] can no

EMC N/A | 59894/ longer enroll employees for fingerprint scans by touching the attached fingerprint reader
while performing the Edit Employee PIN function.

EMC N/A | 84245| Programmers can no longer override the same descriptor simultaneously.
Context-sensitive help text is now available in Page Design for the following check detail
area configuration options:

EMC N/A | 89966 = Show Seat Number

= Show Previous Round Indicator
= Enable Gestures
You can now view log entries for errors related to the Web Configuration Console (WCC).
The WCC log file is located in the following path:
Engagement| N/A | 86874
<Drive letter>:\Micros\Simphony2\Engagement\WCC\Logs
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View Only privileges that are assigned in the EMC, Enterprise Roles module, are now

Engagement| N/A | 86877| enforced when you attempt to access pages and make configuration changes. Additionally,
the theme color of the page no longer unexpectedly changes after saving.
Engagement workstations assigned to newly created Simphony properties can now connect
Engagement) N/A | 86897 to the Engagement server at the Welcome screen.
Internal Ops functions 9-9-9 and 1-2-2-6-clear-clear-clear now work as expected on
mTablet E Series devices while running Engagement. After you sign onto an Engagement
Engagement| N/A | 86909| workstation and press the 9 button three times (9-9-9), the mTablet’s stats from the PMC,
General tab appear. After you press 1-2-2-6 and the Clear button three times in succession
(Clear-Clear-Clear), the current Engagement software build version appears.
Employees without the Engagement option set in the EMC can no longer log in to the
Engagement| N/A | 89049| Engagement site. Additionally, all new users can now log in to Engagement without
updating the database.
When you create or clone new pages, the system now checks to see whether existing page
Engagement| N/A | 89175| names exist in an organization. Attempting to duplicate a page name results in the
following message: Page name is already in use, please provide a unigue name.
Install N/A | 55527 The Slr_nphony I_nstaller program no longer shows the Install failed to execute error when
upgrading mymicros.net.
Interfaces 35488| 69035 When ov_ertenderlng, the standard interface now posts the correct sales itemizer
information.
Interfaces | 36054| 87235| Check totals now calculate accurately when you manually apply tips to a check.
Ops 35466| 68509 When you exempt and re-add a service charge, the tax amount now calculates correctly.
Ops 35877| 79686| You can now add condiment prefixes to combo meal menu items.
Ops 35987| 84247 Ops now loads without error when you restart the Service Host after overriding a
descriptor.
Ops 36071| 86502| Ops no longer returns an error when you ring in anonymous menu items.
ODs 36093| 90068 When you select the Workstation option [12 - Mag Card Entry Required for Employee
P ID], MICROS XProcessor can now read gift cards from the magnetic stripe reader.
When you select Menu Item Classes option [11 - Add to Guest Count] and split a check
Ops 36125| 89305| with a menu item quantity, the guest count on the split checks now accurately reflects the
number of menu items on the check.
Ops N/A | 86295| Ops now shows the correct theme color and style on Android devices.
Ops N/A | 86504| Refreshing or updating the database now syncs the employee changes to workstations.
ODs N/A | 86525 The [Next] function key now works as expected. After you ring in a menu item and select
P [Next], the focus on the menu item clears from the check detail area.
When you cancel a payment, Ops no longer removes manual charge tips from the check
Ops N/A | 87904 summary and check detail areas.
Ops N/A | 88216 The Change Due dialog box now shows the correct Amount Tendered and Change Due
when closing a check to a quick tender.
Ops N/A | 88265 When you select the RVC parameter option [69 - Auto Combo Returned Menu Items],

you can perform the Auto Combo function on returned menu items.
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ODs N/A | 88580 You can now finalize credit card transactions on mTablet E devices using Verifone and
P MagTek magnetic stripe readers, without being prompted for authorization multiple times.
Ops N/A | 88794| You can now void checks with a stored value card tender without error.
Ringing in an anonymous menu item and then selecting another menu item or attempting
Ops N/A | 89378 . . . .
to navigate to a different screen now prompts you for confirmation only once.
Ops N/A | 89379 EI‘ICE Inquiry now works for all menu item classes regardless of the configured Count
ntry type.
ODs N/A | 89380 Menu items that do not have formatted text for their default name now print in the
P translated text when the workstation language is not English.
Printing 36029| 86505| Dopplebon printers now cut the paper between order chits.
The following mymicros.net reports now show $0.00 priced condiments:
= Menu Item Sales RVC Day/Week/Month Report
Reports N/A | 86829 = Menu Item Sales System Detail Report
= Menu Item Sales System Day/Month/Year Report
= Menu Item Sales System Day/Week/Month Report
Stored 35625| 72283| Operators can no longer reload stored value cards when Transaction Void is on
Value Card '
\S/t;rlfs Card N/A | 88467 Ops retains stored value card (SVC) reload operations when you restart the workstation.
Transaction You can now regenerate the Web Reference file without error and successfully post
; N/A | 84835 . )
Services transactions and add items to open checks.
Transaction If you specify a revenue center, the Get Open Checks method now retrieves checks from
Servi N/A | 84992| the specified revenue center. If you do not specify a revenue center, the Get Open Checks
ervices :
method retrieves checks from the default revenue center.
Transaction The Transaction Services client now displays the overtendered cash amount as Change
; N/A | 88700
Services Due.
Known

The following is a list of known issues.

CR TP .
Module D ID Description
Hardware| N/A 29321 The mWorkstation is not supported with a biometric fingerprint reader.
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Release overview

The Simphony 2.7 MR3 Release Notes describe new features and enhancements for this version of Simphony.

Features and updates

CAL
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Added filtersto the Client Application Loader (CAL) Packages Select Properties dialog box
CRID# N/A
TP ID#: 80280, 80282
Y ou can now:

o Filter property results by Object Number or by Name.
o Select or deselect Show already configured propertiesto show or hide configured deployment schedule
records. Y ou can use thisfilter to prevent erroneously configuring duplicate deployment schedul e records.

Related Links: New CAL 2.x

Added filters to the CAL deployment schedules
CR ID#:. N/A
TP ID#: 80281
Y ou can now include and exclude deployment records on the CAL Deployment Schedules tab using the
following filters:

o CAL Package

e Deployment Type
e Actionto Take

e Deployment Dates

Related Links: New CAL 2.x

Added support for selecting multiple CAL deployment records and properties
CR ID# N/A
TP ID#. 80283
Y ou can now press and hold the Ctrl key to select multiple CAL deployment records on the CAL Deployment
Schedules tab and on the Select Properties dialog box. You can click Select All and Clear All to select or
deselect all properties on the Select Properties dialog box.

EMC

Added support for collecting menu item fees
CR ID#: N/A
TP ID#: 73291
Y ou can now configure a menu item fee as a service charge record. The EMC Service Charge Groups module
allows you to group together all fees (for example, bottle deposit and recycling fee) that apply to a menu item.
When an operator rings a menu item associated with a service charge group, the fees for the menu item are
automatically added to the check.

Related Links: Applying feesto menu items

Added the Employee Permissions Report
CR ID# N/A
TP ID#. 80278
The Employee Permissions Report lists employee permissions and access levels to properties and revenue
centers. This report provides compliance with statutory reporting as required by gaming commissions for casinos.

Related Links: Employee Permissions Report
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Added atab showing configuration statistics
CR ID# N/A
TP ID#: 80523

The Config Statistics tab lets you view information about the number of properties, revenue centers,
workstations, Engagement-enabled workstations, Transaction Services clients, and KDS clients.

Related Links: Enterprise Parameters

EMC and Ops

Auto-combo engine recognizes pre-defined combos
CR ID# N/A
TP ID#: 80461

The[11 - IsDefined Combo Meal] option for combo meals allows Ops to recognize the individual items of the
combo and to override the combo meal if theitemsin the order qualify for abigger discount.

Related Links: Combo and Fixed Price Meals

Removed license codes from Simphony
CR ID#: N/A
TP ID#. 80508

Y ou no longer need licensing codes when:

e installing Simphony version 2.7 MR3 and later.
e upgrading to version 2.7 MR3 and later.

e activating the system, workstations, KDS displays, and Transaction Service vendors.

EMC includes the following user interface (Ul) changes:

e Removed the Licensing tab from the EMC Parameters module.

« Removed the employee role Enterprise Parameters Licensing from the Roles module.
e Removed the license status icon from the EMC status bar.

Related Links: Simphony Licensing, Enterprise Parameters, EM C Status Bar

iPad

Added support for Apple® iPad devices running iOS version 8 with Simphony
CR ID# N/A

TP I1D#: 80800
Simphony version 2.x now supports Apple® iPad devices running the iOS version 8 mobile operating system.

Peripherals

mTablet E-Series 8" and 11" tablets support the MICROS mTablet E-Series sleeve that includes a magnetic card reader
CR ID#:. N/A

TP ID#: 69014
mTablet E-Series workstations now support the mTablet E-Series sleeve. The following features are not
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supported:

e Barcode scanner (8" sleeve)
e Point to Point Encryption magnetic read head capabilities (8" and 11" sleeves)

Download the drivers from the link provided in the driver installation article to manually install the VeriFone
E23x Card Reader Driver, and then manually install them.

Related Links: Installing the VeriFone E23x Card Reader Driver

Workstations

Simphony 2.7 MR3 now supports the mWorkstation. This workstation runs the Windows 8.1 operating system.
CR ID#: N/A
TP ID#: 79321
The mWorkstation cannot be used to run the ServiceHost components (KDS Contraller, Labor Cache,
Reporting Cache, etc.).
Additionally, the following limitations and requirements exist:

o Thefeature that detects when the cash drawer cables are swapped does not function. Thisissueisonly a
concern in environments where 2 drawers are used on a single workstation.

o Modify the power saving settings on the mWorkstation to prevent suspend or hibernation modes. These
modes will cause issues with communications, and check sharing operations. The hardware may hang
when you try to resume from either of these states, and you may need to perform afull reboot to resume
operations.

e The use of Fingerprint readers are not supported at thistime.

Related Links: Workstation Comparison Chart

System requirements

Simphony version 2.7 MR3 is compatible with the following platforms:

Category Supported Products
Operating . .
System Microsoft Windows Server 2008 R2
Databases Oracle Database 11g, Microsoft SQL Server 2008

R2

Related Links: Simphony 2.x Platform Capabilities Matrix, System Security Enhancements

| nstallation and upgrade

Download theinstallation file Simphony_2.7_MR3.iso from
http://downl oads.micros.com/micros/simphony/Simphony 2.7 MR3.iso.
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| ssues

Resolved

Thefollowing isalist of issues that have been fixed since the last release.

CR TP —
Module D D Description
CAPS N/A | 84814 Check and Posting Service (CAPS) no longer takes timeto initiate with many

revenue centers.

The Service Charges module in EMC now shows updated context-sensitive help
Documentation| N/A | 81826| (CSH) for option [13 — Cash Tips], and the documentation contains instructions to
configure service charges.

Direct Posting Service (DPS) now posts the number of times a check was printed to

DPS 33053| 80507 :
mymicros.net.
DPS 35815| 81074| The DPS now posts the check duration to the Reporting database.
EMC 35676| 74008 You can no longer modify inherited menu item records using copy and paste
functions.
The context-sensitive help for the Properties module options Distribute I nherited
EMC 35728| 75432 Recordsand If destination record isinherited, create override now describes the
correct behavior.

Extensibility | 35748| 75447| Extensibility event handlers for authorization events are now called appropriately.

The context-sensitive help description for RV C Parameters option [6 - Prorate
Interfaces 35694| 74448| Itemizerswhen Posting a Partial Tender to a PM S| has been revised to reflect its
correct behavior when desel ected.

Pressing Item Done now stops the ordering of the current item and the current item

Ops 35727} 75364 no longer remains highlighted in the check detail area.

Deselecting Tax Parameters option [2 - Require a Reference Entry with Tax
Ops 35770 76471 Exemptions] now preserves and accurately reports the correct tax exempt statein
all successive rounds.

Cover charges are now applied to guest checks when the operator enters the number

Ops 34698 82780 of guests at the beginning of a transaction.

The MagTek DynaPro Mini card reader no longer causes Ops to stop unexpectedly

Peripherals N/A | 83589 when the operator cancelsasign in.

To print Unicode characters properly spaced on guest checks and customer receipts,
you must configure the IDN-V multilingua card (firmware version M4.08) using
the Oracle MICROS Font Management Utility version 1.15.

Printing 35602| 71932

See Printing Unicode characters on guest checks and customer receipts for
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configuration instructions.

The following mymicros.net reports now show $0.00 priced condiments:

e Menu Item Sales by Revenue Center Report

Reports 35730| 75466 e Menu Item Sales by Revenue Center Detail Report
e Sales Comparison Report
The System Interface Module (SIM) now shows the accurate taxable sales of items
SIM 35634| 72894| with a 0% tax rate when you select Tax Parameters option [8 - Post Taxable Sales
When the Tax RateisZero].
The @CheckData SIM variable now retrieves inclusive taxes applied to a check
SIM 35714| 80589| when you select Tender Mediaoption [24 - Print Inclusive Tax or VAT Lineson
Check or Receipt].
Egateway now handles authentication requests when alarge number of
System 35833 83978 workstations restart simultaneously after upgrading the database.
Taxes N/A | 83095 Tax isno longer reapplied to tax exempted autofire checks after firing.
™S 35789| 77178 Oon Wi nd_ows 32 W(_Jrkstatl ons, shortcut menus (context menus) now close when the
operator is automatically logged out.
Transaction The Transaction Services client no longer stops responding when refunding checks
. 36006| 77753| . )
Services using the cash payment driver.
-Sr;raclség on N/A | 77754 Applying apartia refund no longer closes the check with an amount due.
Transaction When the Transaction Services client retrieves configuration information, the
. N/A | 84265
Services revenue center no longer changes.
Known

There are no known issues in this version of Simphony software.
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Release overview

Simphony Version 2.7
General Release
Simphony 2.7 MR1
Simphony 2.7 MR2
Simphony 2.7 MR3
Simphony 2.7 MR4

Previous Version Next Version

Simphony 2.6 Simphony 2.8

The Simphony 2.7 MR2 Release Notes describe new features and enhancements for this version of Simphony.
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Features and updates
CAL

Client Application Loader (CAL) package now transfers files silently from server to client
CR ID#: N/A
TP ID#: 63031
The new CAL package copies files from the server to the client without showing dialog boxes, status meters, or
notifications on the client workstation. This silent transfer of files allows cashiers to continue to ring sales using the
Ops client while the files are being transferred, minimizing the amount of downtime. After the package files are
transferred, the client performs required tasks (for example, restart Ops), which temporarily stops the order taking and
sales process.

DPS

Direct Posting Service (DPS) now posts weather information to mymicros.net
CR ID#: 33619
TP ID#: 27743
DPS now posts weather conditions, high and low temperatures to the Simphony database
OPERATIONS_DAILY_TOTAL table when mymicros.netis configured for this feature.

DPS now posts reference and reason code information to mymicros.net
CR ID#: 35014
TP ID#: 37207
DPS now posts reference and reason code information for Media Loans and Media Pick Ups to mymicros.net.

ECM

Numerous Enterprise Cash Management (ECM) feature enhancements are available
CR ID#: N/A
TP ID#: 15639
ECM module enhancements can now support funding sources, expanded template information, privileges, simplified
workstation till assignments, and new till-based transactions.

Related Links: Enterprise Cash Management

EMC

A new reporting role exists in EMC
CR ID#: 35769
TP ID#: 77114
A new Roles — Reporting row has been added to EMC > Enterprise > Configuration > Roles > EMC Modules >
Personnel area. The View and Edit options regulate the behavior of the Employee Maintenance > Reporting tab,
which regulates a user's settings for the mymicros.net reporting application. The Audit Trail in EMC > Enterprise /
Property > Tasks now shows a history of any role permission changes made to the Roles — Reporting row as well as
changes made to any fields on Employee Maintenance > Reporting.

Related Links: Configuring reporting roles, Configuring Employee Maintenance reporting permissions
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Extensibility

Actual discounts now link to parent coupon detail
CR ID#: N/A
TP ID#: 72784
Actual discounts that result from a coupon being applied to a check now reference the parent coupon detail. This
allows authors of extension applications to identify coupon detail and discount detail.

Ops

Support for check operations Follow Me has been introduced
CR ID#: N/A
TP ID#: 57132
The suspend and resume feature has been enhanced with a Follow Me checks feature. Follow Me allows you to
suspend a check and resume it from any workstation in the same revenue center.

Related Links: Suspending checks across workstations in a revenue center

Cash drawer can now open upon service charge
CR ID#: 35513
TP ID#: 69700
When the [36 — Do Not pen Drawer if Subtotal is 0.00] option is selected, you can select the new [65 — Allow open
of Cash Drawer on Service Charge] option. This feature allows a cash drawer to open when the subtotal is $0.00
and the guest check only contains a service charge greater than $0.00. For example, the guest check may have a
subtotal of $0.00 and contain a stored value card for $20.00.

Related Links: Control Parameters

Caps Lock is now available for on-screen keyboard
CR ID#: 35495
TP ID#: 69217
This feature addresses the inconsistent case behavior found between custom, default, and physical keyboards in
Simphony versions 2.5, 2.6 and 2.7. You can select the new [53 — Caps Lock Enabled for On-Screen Keyboard]
option to set the default on-screen keyboard input to uppercase letters. When this option is selected, operators must
press the Shift key to type in lowercase letters. When you deselect the option, the default on-screen keyboard inputs
in lowercase letters and the operator must press the Shift key to type uppercase letters. This option does not affect
physical and custom keyboards. To configure this option, in the EMC, select Enterprise / Zone / Property / Revenue
Center, select Setup, select Format Parameters, and then select Options.

Related Links: Known issue

Page Design

Increased the quantity of Screen Lookup (SLU) priorities
CR ID#: N/A
TP ID#: 36343
The quantity of priority styles available in the Page Design module has increased from 5 to 10.
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Peripherals

Support for MagTek DynaPro Mini has been added with mTablet E-Series
CR ID#: N/A
TP ID#: 65031
The mTablet E-Series now works with the MagTek DynaPro Mini handheld card reader. Users can:
e assign an employee 1D card
e authorize a prompt with an 1D card
e sign in to Ops with a magnetic ID card
e close a check to a room with a room card

Related Links: mTablet Configuration

Printing

Printing tax rate per item on receipts is now supported
CR ID#: N/A
TP ID#: 73376
It is now possible to print a menu item’s tax rate on guest checks and customer receipts as well as in the journal. This
enhancement is required for compliance with New York tax regulations.

Related Links: Printing tax rate per item

System

Database and log file allocation has been improved
CR ID#: N/A
TP ID#: 70788
The client database is now configured to grow in fixed increments (for example, 10MB at a time). The logging mode
on the client database is set to Simple Mode to prevent the log file from growing. Prior to this release, disk space was
over allocated to the Simphony database and log files, causing the client hardware to consume the available disk
space on the hard drive. Contact Product Management for additional details.

Taxes

Taxable sales now post zero percent (0%) tax rate to mymicros.net
CR ID#: N/A
TP ID#: 66907
Taxable sales now post to mymicros.net when the tax rate is set to 0.00%. In cases where there are no taxes, the
taxable amounts can be used for reporting in mymicros.net. Previously, when applying a 0% tax rate to a check, it
was not reported in the TAX_DAILY_TOTAL table in mymicros.net.

The new option [8 — Post Taxable Sales When the Tax Rate is Zero] appears in EMC > Enterprise / Zone /
Property / Revenue Center > Setup > Tax Parameters > Options.

e When you select option [8], the 0% tax rate posts to the TAX_DAILY_TOTAL table in mymicros.net.

e When you deselect option [8], the 0% tax rate does NOT post to mymicros.net.

Related Links: Tax Parameters
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System requirements

Simphony 2.7 MR2 is compatible with the following platforms:

Category SupportedProducts
Operating Microsoft Windows Server 2008 R2
System
Databases Oracle Database 11g, Microsoft SQL Server 2008 R2

Related Links: Simphony 2.x Platform Capabilities Matrix

(http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/Simphony_v2_Platform_Capabilities_Matrix.xlIsx),
System Security Enhancements
(http://www.micros.com/ServicesAndSupport/InformationSecurity/OperatingSystemSecurityEnhancements/Operating)

Installation and upgrade

Download the installation file Simphony_2.7_MR2.iso from
http://downloads.micros.com/micros/simphony/Simphony_2.7_MR2.iso.

Issues

Resolved

The following is a list of issues that have been fixed since the last release.

Module CRID -:-g Description
The Audit Trail in EMC > Enterprise / Property > Tasks now shows a history of any
. . setting changes made in the new CAL module. For example, if you change the new
AuditTrail | 35836 62007 CAL module by setting a package to deploy, the audit trail search query for EMC
CAL Packages includes a record for that deployment action.
Credit Card Service Host no longer stops unexpectedly when more than 30 menu items on a guest
i 35807 77872 : o
Driver check are sent to Shift4 for authorization.
Credit Card The track information field now contains correct information for Shift4 token requests
Driver N/A 77860 | associated with the use of manual entry, cards with track 1 data, cards with track 2
data, and cards with data on both track 1 and track 2.
When an extension application is defined at the enterprise and is then overridden at
Database N/A 60747 the zone or property, the property workstation now inherits and loads the correct
version of the file (for example, .DLL) that is defined at the zone.
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TP

Module CRID ID Description
Validation did not occur when settled credit card batch records were transferred to
Data mymicros.net, causing duplication inthe CREDIT_CARD_DAILY_BATCHtable.
Transfer 34963 47650 | Data Transfer Service (DTS) now confirms that a record exists before writing it to the
Service CREDIT_CARD_DAILY_BATCHtable in mymicros.net. DTS does not transfer
credit card batch records that have already posted to the Location Activity database.
Data When an exception occurs during database purging of a table, the subsequent tables in
Transfer N/A 76803 | the purge sequence continue to be purged. Previously, if purging failed for one table,
Service all subsequent tables also failed to purge.
Direct Menu items rung with a decimal quantity are now shown correctly in mymicros.net
Posting 32191 9438 | reports. Previously, decimal quantities were rounded to the nearest whole number on
Service mymicros.net reports.
Direct Direct Posting Service (DPS) now caps the ServiceChargeCount value to continue
Posting 33154 18555 | posting to mymicros.net without arithmetic overflow errors. If any values exceed the
Service cap, they are written to the log file on the Application server.
Direct DPS could not post data contained in MREQUEST to mymicros.net if the menu item
Posting 34325 31390 | master database ID was zero (0). The DPS logic was changed so the menu item master
Service database ID can be obtained if it is 0 by using the menu item definition database ID.
Direct . . . . . .
. Negative checks no longer show in the mymicros.net Financial Reports as Carried
Posting 35117 54115 .
. Over or Outstanding once they are processed and cleared.
Service
Direct DPS no longer throws the invalid data type exception error. DPS now reads the
Posting 35700 80983 | FINANCIAL_CALENDAR table to calculate the business date if it fails to read from
Service the FINANCIAL_CALENDAR_HIST table.
Direct
Posting 35808 77782 | DPS now posts the GMS table alerts to mymicros.net without a delay.
Service
Direct Stored value card extensibility details associated with a check are now posted to the
Posting 35866 | 80984 : eC y P
. location activity database.
Service
Direct An error occurred in the DPS log and check information did not post to mymicros.net.
Posting N/A 71507 | The query parameter name was changed so that check information now posts to
Service mymicros.net.
Menu item group price substitution now functions correctly with automatic discounts.
EMC 33711 23365 | Amount Off and Percent Off discounts both apply the correct automatic discount
value.
You can now change the value in the revenue center data extension without getting an
error. Previously, after a Data Extension was entered (in EMC > Enterprise >
Configuration > Data Extensions) for Table Type 20 - Revenue Center, it was not
EMC 33986 26737 | editable. Thus, after entering a value in this data extension within EMC > Property >

Setup > RVC Configuration, saving, and re-opening, that value did not appear. When
a user attempted to change the value in the data extension, an error appeared. This has
been corrected.
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EMC

35299

62848

Translated legends of Page Design buttons are now copied. Prior to this release, in the
Page Design module, when a button with a translated legend was copied and pasted,

the translated legend was copied as "????". Then after synchronization occurred
between EMC and Ops, the incorrect legend value appeared on Ops as well.

EMC

35428

67526

New DLL versions are now loaded to the workstations. The EMC and the
workstations now use the updated DLL versions.

EMC

N/A

71170

After Simphony 2.6 Hot Fix 3 was installed, a Simphony deployment could not be
changed from one hotfix package to another without changing the general release
(GR) version. Simphony deployments can now be switched in EMC > Enterprise >
Setup > CAL Packages > Deployment Schedules.

1. Highlight a CAL Package and click the Change Package Version hyperlink.
2. The Choose CAL Package For Deployment list includes the proper hotfixes.

EMC

N/A

71171

When adding a new property and copying from an existing property, the Set All link
(in EMC > Enterprise > Setup > Properties > Add Property) now selects all modules.
You no longer need to manually select each module from the Modules to Copy list.

EMC

N/A

71172

The time required to clone a property is faster with Simphony v2.7 MR2.

EMC

N/A

71190

The MICROS Application Loader did not launch Remote EMC Client after upgrading
the enterprise server to Simphony v2.6 Hot Fix 2. The MICROS Application Loader
now launches the Remote EMC Client after the enterprise server is upgraded to v2.6
Hot Fix 7. However, you need to uninstall and re-install EMC if the MICROS
Application Loader was downloaded from an enterprise that previously had Simphony
v2.6 Hot Fix 2 installed.

EMC

N/A

81639

Attempting to select [55 — Enable the encrypted MSR] (in EMC > Property > Setup
> Workstations > Options > Hardware/Cash Drawer) now shows a warning message
informing users that this option cannot be deselected from the EMC once it is selected.

Engagement

35826

80420

Simphony now uses the internal IP address to retrieve the license status when
registering users for the Engagement feature. The EGateway URL has been added to
the web.config file and is by default set to the relative path of the EGateway Service.
If you are not using localhost: 8080, set the EGateway URL to the absolute path of the
EGateway Service (forexample, http://125.12.43.12:8080/Egateway/Egateway.asmx).

Install

N/A

65441,
71958

Hotfix CAL packages for Service Host and KDS Controller (postokdshandler) now
appear correctly in the EMC CAL Packages tree.

Interfaces

35591

71534

Closed guest checks with a negative subtotal no longer post positive subtotal values to
the property management system (PMS) interface. Previously, when option [32 —
ON=Post Amount Tendered to PMS; OFF=Post Amount Due] was selected (in
EMC > Enterprise / Zone / Property > Configuration > Tender/Media > Options >
Interface Options), negative guest checks that were tendered using either the Request
or Specified Cash Payment tender resulted in the subtotal amount being sent to the
PMS interface as a positive amount even though the check detail amount was
negative. This has been corrected.

Interfaces

N/A

71173

PMS inquiries are now sent from Ops with the correct XON/XOFF messaging.

iPad

N/A

67143

Macros now execute on an Apple® iPad device with Simphony v2.7 MR2.

KDS

N/A

30201

The Backup KDS Controller Backup Is Active setting was out of sync with all
databases. After selecting the [Activate Backup KDS] function key on the
workstation, the KDS_Controller table now appears the same on all databases.
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KDS

N/A

79758

When you select either Menu Item Class option [59 — Allow Item Incomplete Based
on Role] or employee roles option [161 — Allow Incomplete Item] and an operator
rings in a complete menu item and then a parent item without its required condiments,
the check details do not appear in the KDS display until the operator adds required
condiments. Previously, the round details were shown on the KDS display with an
incomplete menu item.

Licensing

35549

71174

If the EGateway web service license check failed due to an inaccessible database, the
system went into demo mode. This caused unexpected consequences, such as DPS
posting transactions to the wrong business day. Now if the EGateway web service
cannot read the licensing information from the database, an exception error appears
and the EGateway web service does not start.

Loyalty

35605

71953

You can now apply a coupon discount to a transaction, perform a service total, pick up
the check, and void the discount successfully without receiving an error.

OPQOS

N/A

71404

You no longer get an exception error nor does the system attempt to close the device
when a UPOS cash drawer initializes.

Ops

32193

4846

Role transaction privileges [49 - Authorize/Perform Posting of Menu Items in Priv
Group 1], [50 - Authorize/Perform Posting of Menu Items in Priv Group 2], and
[51 - Authorize/Perform Posting of Menu Items in Priv Group 3] are now properly
enforced. Previously, all operators could ring in menu items belonging to privilege
group 1, 2, and 3.

Ops

33249

19357

If you ring in @a menu item with an automatic discount, use the Copy Item function,
void one of the menu items, and use the Copy Item function again, the check detail
area now shows two menu items with two automatic discounts.

Ops

33890

25352

The employee role option [17 - Auth/Perform Assign Cash Drwr 1&2; Unassign
Drwr from Others] (in EMC > Enterprise > Configuration > Roles > Operations >
Miscellaneous) has been modified to avoid potential security issues with unassigning
another person’s cash drawer. The "Enter your ID" prompt no longer appears before
assigning/unassigning a cash drawer to/from others. This prevents an employee from
unassigning a cash drawer from another employee.

Ops

34489

35174

A negative transaction with forced condiments now uses the correct thresholds.

Ops

34773

28793,
73295

When you select the RVC parameter [53 — Use Revenue Center Check Numbers],
Ops assigns different group numbers for checks begun on different workstations for
the same table. When you deselect option [53], the group number remains the same

because each workstation controls the table/group number calculation.

Ops

34838

43806

Selecting option [15 — Allow Fast Transactions] in EMC > Revenue Center > Setup
> RVC Parameters > Options allows the operator to manually post menu items and
use the barcode entry function. When you deselect option 15, the operator cannot
create a check using a barcode function and will receive an error when attempting to
do so.

Ops

35145

55870

The custom reports (Employee Financial, Property Financial, RVC Financial, Serving
Period Financial) now appear on the Print tab when the reports are run.

Ops

35236

59635

Adding a quantity of priced condiments to a check resulted in an incorrect calculation
of the price. When you enter a value in the Text field of a button, the count now
applies that value multiplied by the condiment price. Previously, when a value was
entered in the Text field of a button, the count applied that value incorrectly to the
condimentprice.
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Ops

35278

62265

Ops now calculates the tax correctly when ringing in a menu item that has tax and
auto service charge and another menu item that does not have tax or auto service
chargeapplied.

Ops

35293

62609

After completing a split check operation, you now return to the page on which the
Split Check function is defined.

Ops

35296

62696,
65419

The [Auto Block Check Transfer] function now transfers all open checks in the
revenue center (RVC). Previously, pressing the [Auto Block Check Transfer]
function key only transferred the checks belonging to the workstation.

Ops

35360

64355

An employee ID can now only be assigned to one employee. If a user attempts to
assign an employee ID number that is already taken, a message appears stating that the
ID is already in use. Previously, after using the Assign Employee ID function on the
workstation and sliding a magnetic card, upon subsequent attempts to assign another
employee ID with the same card, the employee 1D was assigned to multiple
employees.

Ops

35375

64762

The [Auto Block Check Transfer] function no longer prompts twice for
authorization to transfer each check; only one authorization prompt appears.
Additionally, the dialog to select transfer employee number now shows all employees
with checks in the current revenue center.

Ops

35415

71399

Combo meal updates did not refresh on workstations. Now when you select option [58
- Auto Combo Items On The Fly] (in EMC > Revenue Center > Setup > RVC
Parameters > Options), the combo meal is created when the quantity of the menu item
to constitute the combo is reached.

Ops

N/A

63610

Buttons now appear normal with text in Ops and are no longer blank.

Ops

N/A

66210

The check detail area now appears properly in Windows CE workstations.

Ops

N/A

69575

You no longer get an exception error nor does Ops stop unexpectedly after signing in
to Ops on a Windows CE workstation where the default Transaction Page is a Tabbed
Grid Check SLU.

Ops

N/A

70208

Control Parameters option [24] is no longer ignored for partial error corrects. When the
operator voids entries in the current service round, the entries reflect as VVoid Totals on
the Financial Reports after the check is closed. Previously, a partial error correct was
treated as if option [24 — Treat Error Corrects as VVoids] (located in EMC >
Enterprise / Zone / Property / Revenue Center > Setup > Control Parameters >
Options) was deselected.

Ops

N/A

71191,
71192

Tax and service charge amounts are now calculated from the subtotal after you apply
automatic discounts when options [3 - This is an Item Discount] and [31 - Net
Automatic Service Charge Itemizer] are selected (in EMC > Enterprise / Property
> Configuration > Sales > Discounts > General > Options) for all automatic
discounts and discount rules.

Ops

N/A

74995

After a suspended check is service totaled, the correct value now appears in the
ROUNDNUMBER column of the Checks Table.

Ops

N/A

76951

Screen Look Up (SLU) items using Next Page/Panel now display the correct menu
item names. Previously, menu item class settings were overwritten in memory when
the DataStore database was refreshed or the APPLICATION_TEXT table was
updated.

Ops

N/A

78531

Ops now reads and processes credit cards with track 1 data.
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Ops

N/A

78549

A charge tip amount that is entered manually in Ops prior to tendering no longer
prompts for confirmation and does not post as change due on the final tender.

Ops

N/A

79137

If the menu item class or definition does not exist on a check that is picked up, the
user is not allowed to select a menu item. This workflow is designed to prevent the
Condiment Orderer from appearing as it cannot determine whether the menu item is
complete. Previously, an exception was thrown when a menu item class or definition
was not present on a picked up check. This has been corrected.

PMC
Reports

33212

19236

You can now sort the Time Period Summary Report by the Time Periods column.

PMS

35212

58405

When a partial payment is made on a negative check, the correct amount is now sent
to the property management system (PMS). Previously, the system sent the negative
check total instead of the partial payment amount, which generated an error in Ops
stating, "The total is not equal to the sum™.

PMS

N/A

79414

The Service Charge total in the standard PMS interface charge posting message is no
longer overstated by the amount of the manual charge tip that was entered. Prior to
this release, the Service Charge totals were doubled when a charge tip was manually
added to the check.

Printing

32929

18081

When the Print Customer Receipt function was used to print a check, and that check
was then printed again using the [Reprint Closed Check from List] function, the first
menu item (MI) on the check was missing. The first M1 that is ordered now appears on
the check when it is reprinted using the [Reprint Closed Check] function.

Printing

35430

71403

If you have one or more tax rates exempted, the Tax Exemption total now prints the
correct value on the receipt. Previously, when selecting Tax Parameters option [4 -
Enable Canadian GST] (in EMC > Enterprise / Zone / Property / Revenue Center >
Setup > Tax Parameters > International Options) and exempting all tax rates (using
either the [Tax Exempt All] function or exempting each tax individually until no tax
rate was applied), the Tax Exemption value printed on the receipt or guest check
showed $0.00 instead of the exempted total.

Printing

35465

68499

Service charge exemptions applied to partial tenders now print only once.

Printing

35469

68526

Splitting off item quantities from previous rounds resulted in indistinguishable void
and menu item quantities appearing on the order device display (in non-Dynamic
Order Mode (DOM)) and order receipt. Now after you split off a quantity of menu
items from a previous round, the order device display and receipt show the original
quantity of items voided, plus the original items separated.

Printing

35494

69198

The date now appears in the correct format on the guest receipt for the selected Locale
String and Locale ID (set in EMC > Enterprise > Setup > Languages >
Miscellaneous) when you select option [2 — Use DDMMY'Y Date Format] in EMC >
Property > Setup > Property Parameters > Options. Selecting option [2] overrides
the Language module Locale values and prints the date as date/month/year (for
example: 30 Oct “14).

Printing

N/A

71130

When the operator reprints a closed check, taxes are not recalculated and tax
exemptions do not print. Previously, when using the Reprint Closed Check function,
the tax was not calculated or shown in the check detail area and exempt taxes were
added to the receipt. When the check was sent to the printer, taxes were calculated
correctly but never added to the check total.

Printing

N/A

76843

Order receipts now show the correct line feed spacing at the top and bottom.
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Reports

35419

71398

When Employee A started a check and then Employee B used currency conversion
and tendered that check using a non-base currency, the tender totals were reported on
Employee B's Employee Financial Report. However, Employee A’s report showed the
currency total in the "Currencies in Bank™ section with an incorrect number of decimal
places and without the foreign currency type. When you select RVC Parameter option
[7 —Post Tender (only) to Transaction Operator] in EMC > Revenue Center >
Setup > RVC Parameters > Posting, the tender and currency are now associated with
the employee paying the check to the foreign currency.

Reports

35758

77857

The Property Financial Report no longer adds the Rounding Total to the Net Sales
when you select option [87 - Rounded Payments and Change] or [56 — Round
Change Due].

Reports

N/A

77998

A deposit refund no longer appears in the Credit Total line on the Property Financial
and Employee Financial Workstation reports. Previously, when a deposit refund item
was configured as a service charge in RVC Parameters, the deposit amount was added
to the Credit Total on these reports. This has been corrected.

SIM

34126

28428

The @USERENTRY variable in the SIM script did not return the value entered by the
operator, so it did not appear correctly in Ops. Ops now shows a dialog box with the
numbers and characters that the user selected.

SIM

N/A

66427

SIM now prints the trailer and header lines correctly on a guest check and a customer
receipt for regular and fast transactions.

SIM

N/A

81465

Numeric key inputs during SIM script execution are no longer captured in payments
on Windows 32 workstations.

Totals
Posting

35451

71400

Data was written to the TOTALS table incorrectly if a shift was reset before service
total. Now a snapshot of the employee and cashier shifts is taken at the beginning of a
transaction. If the shift is then automatically reset due to a business date change, the
shift numbers are now updated before posting to the TOTALS table.

Totals
Posting

35483

68849

When a Void Reason ID greater than 255 was applied to a check, the MREQUEST
record did not post to the Check Posting database. This resulted in inconsistencies
between Ops and reports. Now all Void Reason check data is posted correctly to the
Check Posting database.

Totals
Posting

13554671

25958

There was a problem with the manner in which the next guest check number was
being determined by the system. This could result in non-contiguous check number
assignments. This has been corrected.

Totals
Posting

N/A

55635

Void Count and Total were incorrectly shown in the control section of the workstation
Financial Report when quantity menu item voids (for example, void [3] quesadilla)
were performed. Now, the workstation Financial Report VVoid Count represents the
number of times VVoid was pressed, not the number of items voided. In addition, the
Void Total now shows the value of the items actually voided, not the full amount.

Totals
Posting

N/A

78342

The Check and Posting log file no longer shows a "Compare Check details" failure log
message with Tender/Media options [91 — Cash Management Transaction Item]
and [92 — Affects Cash Pull Threshold] selected.

Totals
Posting

N/A

81112

The subtotal of a check is no longer added to the net sales total each time the check is
suspended.
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Known

The following is a list of known issues.

CR | TP -
Module D D Description
If you use Microsoft Windows CE with a physical keyboard, the letters appear in lowercase as
this environment does not recognize the Caps Lock or Shift keys. The default and custom on-
Ops 35495| g9217|Screen keyboards behave correctly with the Shift key.

Related Links: Caps Lock is now available for on-screen keyboard
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Release overview

The Simphony 2.7 MR1 Release Notes describe new features and enhancements for this version of Simphony.

Features and updates

Install

Client Application Loader (CAL) package install media no longer contains stunnel
CR ID#: N/A
TP ID#: 76800

CAL no longer implements the stunnel package. The current version of stunnel is installed within the Simphony
enterprise and is used only to process payment card batches.

Related Links: Loadable Credit Card Payment Driver Configuration

mymicros.net

Simphony supports mymicros.net8.4.1
CR ID#: N/A
TP ID#: 76952
The installation of Simphony v2.7 MR1 now distributes mymicros.net version 8.4.1.
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System requirements

Simphony 2.7 MR1 is compatible with the following platforms:

Category SupportedProducts
Operating Microsoft Windows Server 2008 R2
System
Databases Oracle Database 11g, Microsoft SQL Server 2008 R2

Related Links: Simphony 2.x Platform Capabilities Matrix
(http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/Simphony_v2_Platform_Capabilities_Matrix.xlIsx),
System Security Enhancements
(http://www.micros.com/ServicesAndSupport/InformationSecurity/OperatingSystemSecurityEnhancements/Operating)

Installation and upgrade

Download the installation file Simphony_2.7_MRL1.iso from
http://downloads.micros.com/micros/simphony/Simphony_2.7_MR1.iso.

Issues

Resolved

There are no resolved issues in this version of Simphony software.

Known

There are no known issues in this version of Simphony software.
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Copyright Information

This articleis a quick reference guide to features, enhancements, and revisions for Simphony 2.7.
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= 1 Copyright Information
= 2 Prerequisite Knowledge
3 Document Overview
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5 New Features
6 Enhancements
7 Revisions
8 Seedlso

Prerequisite Knowledge

This document assumes the reader has the following knowledge or expertise:
= Understanding of basic network concepts

= Experience with Microsoft Windows platforms and terminology
= Familiarity with this product line and its hardware, software, and peripherals

Document Overview

This document includes the following sections:
Simphony Version 2.7

What'sNew _ o _ _ . General Release
This section describes new featuresin this software release. A new feature is one that provides capabilities that were not Simphony 2.7 MR1
What Sa\I/E?:Ihe;?]I selc? previous versions. Simphony 2.7 MR2
. - . Lo . . Simph 2.7MR3
This section describes enhancements in this software release. An enhancement is a change made to improve or extend an S mghg% 27MRA4A
existing feature, under the following criteria: '
= Thebasic feature or functionality already exists in the previous release. m&"'ﬁfﬁm m
= The change adds to or expands on the current process — it does not replace it. This differs from arevision that corrects a phony 2 prony =
problem.
What's Revised

This section describes issues that have been corrected. A revision is a correction made to an existing form, feature, or function, using the following criteria:

= Theitem must be part of the previous version.
= The change must replace the current item or remove it from the application.

Terminology

= A Fix ID isaninternal tracking number used by R&D. This|D is primarily used by R& D personnel; it is helpful for mapping fixes to documented items.
= A CR#isa"Change Request ID" that is generated during the escalations process. When a case is started at the Support Center and the issue is determined to be an
application defect, a Change Request is created, informing R& D that an issue needs to be fixed.
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Obtaining/I nstalling the Software

Theinstallation file is named Simphony_2.7_GR.iso; it can be downloaded from
http://downl oads.micros.com/micros/'simphony/Simphony_2.7_GR.iso

New Features

Fix ID

| Feature

CR#

CAL

40526

Support for distributing client applicationsfrom alocal property server has been added

Simphony now supports distributing client applications from alocal property server. With the Distributed CAL (DCAL)
feature, you can configure one or more service hosts above a property or within a property as adistributed CAL server.

See the Distributing Client Applications from the Local Property Server article for more information.

34103

67748, 71732

New CAL package for Android mobile operating system has been introduced
Simphony includes anew CAL package to install Service Host on devices running the Android mobile operating system.

See the Simphony Android Configuration article for more information.

Cash Management

15639

Support for the Enterprise Cash Management (ECM) module has been introduced

Simphony now includes the ability to track the flow of physical currency and other designated tenders through a store from
the point of reception (for example, cash tender, Paid-In, Change Order), as it moves through the operation (from Tills to
Safes or Bank Deposits) to the point of exit (for example, Bank Deposit, Paid-Out to vendor, change given). ECM also
provides reporting and auditing of receptacles (Safes, Tills, Bank Deposits).

See the Enterprise Cash Management article for more information.

EMC

61722

Ability to manage Client SQL SA login password separ ate from SQL database login has been introduced

Privileged System Administrators can now manage the Client SQL SA login password independent from the SQL database
login. A new field, Password for SA which accepts a maximum length of 64 characters, has been added to the Property
Parameters module. Once the SA password is updated, the property gets this change on its next database sync, and on its
next reboot, implements the change.

A new Security tab has been added to the Property Parameters module. The newly introduced Password for SA field residesin
thistab along with install user/database credential fields that previously existed in the Workstations tab.

To provide usersthe privilege to update the SA password,

1. Navigateto EMC-> Enterprise level-> Configuration tab-> Personnel-> Roles-> EMC Modules tab
2. Under Property Module enable the rightsto View and Edit I nstall User Security and Install DB Credentials

With this release, the privilege Install User Security/DB Credentials has been separated in to two fieldstitled I nstall User
Security and Install DB Credentials. The SA Password is keyed to DB Credentials flag.

35265
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3. Click Save
Toupdatethe Client SQL SA password,

1. Navigateto EMC-> Property level-> Setup tab-> Parameters-> Property Parameters-> Security tab
2. Enter anew password in the Password for SA field

/ General | Search | Options | Workstations | Timekeeping | Calendar }( Security |

User Security Credentials

Install User Security Username [12345

Install User Secunty Password |123“'5

User Databage Credentials

Databage Usermame I

Database Password |

48522, 67365

See the Printing Right To Left Reading Languages article for more information.

[ Password for S4 | I
3. Click Save
EMC and Ops
8106 Trandation tool has been added to L anguage module 31055
The new Translation tab has been added to the Language module in EMC-> <Enterprise>-> Setup tab-> Languages. This
feature trandlates the user interface into the local language and maintains al possible trandation filesin EMC. In Ops, you
can translate, manage, and maintain the Simphony Ops user interface messages. The Translation tool also upgrades older
versions of translation files into newer versions programmatically.
See the Languages article for more information.
48517, Support for printing languagesin right to left oriented languages has been introduced
48518,
48519, It is now possible to set the language reading orientation (right to left or |eft to right), print multiple languages on one guest
48520, check/customer receipt, and print custom numerals on a customer receipt. For example, English and Arabic can print on the
48521, same receipt.

58435

Support for paying at the table using a tablet device has been introduced
It is now possible for the guest to pay the check with a credit card while seated at the table. A server presents a tablet device
to the guest with the check. The guest can view the check, add a tip, share the check, swipe a credit card, sign the check
after the credit card is authorized, and receive areceipt via email and/or printed copy.

See the Pay at the Table article for more information.

Engagement Feature

N/A

The Engagement feature for mTablet E Series devices has been introduced
The Engagement experience lets you:

= Create customized pages online
= Assign (or tag) pages to properties, employees, and/or workstations
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= Run POS operations and execute Manager Procedures
There are two types of pages:

= \Welcome Pages — Initial page that appears on the mTablet E Series device. Y ou can assign different Welcome pages to
workstations.

= Hub Pages — Pages that appear on the tablet after signing in on the Ops client and pressing the Hub function key. Y ou can
assign different Hub pages to each employee.

Pages can contain widgets that allow you to enhance the functionality of workstations. For example, you can have Daily Specidls,
image Slideshows, a Twitter feed, and mymicros.net reports appear on the tabl ets touchscreen.

See the Engagement Feature article and the Engagement Best Practices
(http://downl oads.micros.com/micros/s mphony/Wiki/Docs/WhitePapers/Engagement_Best_Practices.pdf) document for more
information.

60127,
60128,
60129, 60131

mTablet E Seriesworkstations, running the Engagement feature, support Manager Procedur es from the Hub page for
privileged users

The following Manager Procedures are accessible from the Hub page using the WCC (Web Configuration Console) widget:

= Edit Header/Trailer — Check Headers and Trailers can be edited on the Property and Revenue Center levels. If alogo
image has already been loaded on the Enterprise level of the EMC, the image can also be added to a check.

= Bulk Edit MI Prices—Menu Item Prices can be filtered and edited by Revenue Center, Mgor Group, Family Group, SLU,
Menu Item Class, and a Keyword entry.

= Copy Menu Item —New Menu Items (MI) can be added using an existing M| as atemplate. Y ou can use the same price as
the copied MI or enter aunique price. MI’s can be searched by M1 Name. Searches can be filtered by Major Group, Family
Group, MI Class, SLU, and a Keyword entry. A confirmation dial og message appears so you can add more items by
pressing OK or Cancel to exit.

When you access the Hub page and select any of the Manager Procedures, enter your EMC logon credentials to continue. Y ou
must be a privileged user to perform each of the Manager Procedures.

See the Engagement Feature and Logo Printing in Simphony 2.x articles for more information.

Printing

9402

Ability to print logo on guest checks and customer receipts has been introduced
With this release, you can now print the property or revenue center logo on guest checks and customer receipts.

See the Logo Printing in Simphony 2.x article for more information.

30611

Reports

19056

Simphony reporting functions have been enhanced
With this release, the following reporting functions have been enhanced:
= Report Groups capabilities
= Report Templates
= Report Mail functions

See the Reporting Enhancements 2x article for more information.

19261

Default view configuration for workstation reports has been added

Y ou can now set the default view for workstation reports as Property or Revenue Center using the Reportstab in EMC->
<Enterprise/ Zone/ Property / Revenue Center>-> Setup tab-> Control Parameters module.
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Home  Control Parameters
Page  Enterprise

/" General F‘ Configuration ¥ Gptions } Rey ports |

| Reports Default Yiew

Enployee Financid |0~ Froperty =
|Employee Open Check - Property [=]
| Emplayes Closed Chedk 0 - Property =]
| Employee Tip 0 - Property !‘_v]
| Cashier Financial .0+ Property [=]
| Major Group Sales 1 - Reverue Center =]
| Famiy Group Sakes 0 - Property =]
| Manu Item Summary 0 - Property [=]

| Menu Ttem Sales
| Clack-in Status 0 ety

|| vabor Availabiity

| |3cb Code Labor

| Offine Employee Financlal
| Offiine Cashier Financial

oocoooo-=ooo{-E

| |oifine Employee Gpen Check - Reverue Center
| Emplyyee Journal - Property

|| check Journal « Property

| |Employee Frnancial v2 - Preperty

| |Empioyee Financial - YAT - Property

| | Summary + Property
|Employee Section Assigrment Report - Property

Workstation App

42180 Simphony now supportsthe Android mobile operating system
Simphony is now compatible on consumer grade devices running the Android mobile operating system.
See the Simphony Android Configuration article for more information.
Enhancements
FixID | Enhancement CR#
CAL
70453 Microsoft Visual C++ 2012 and 2013 Redistributables packages are now installed on Windows 32 devices.
Microsoft Visual C++ 2012 and 2013 Redistributabl es packages are now installed on Windows 32 devices as a part of the
ServiceHostPrereq2.0 CAL package.
Credit Card Driver
52895, L oadable Payment Card Driversare now supported on Android platform
52896,
52897, 52899 With this release, the following payment card drivers are supported on the Android mobile operating system:
= $$$ on the Net
= CAPMS
= Fusebox
= VisaD
See the Loadable Credit Card Payment Driver Configuration article for more information.
EMC
7736 Access privilegesfor Menu Item Maintenance files and their fields have been enhanced in EMC 31990
EMC Employee Role privileges have been added so that accessto all of the fields within the Menu Item (MI) Master, M
Definition, and M1 Price files can be controlled more precisely. Upon upgrading to this release, all current EMC and POS
client access privilege controls remain enforced. However, al of the fields within these files now have Editable, View
Only, and Exclude privileges available for configuration. By default, all of the new field access levels are set to Editable
(full access privilege).
See the Menu Item Field Level Security Setup 2x article for more information.
45184 Autofire, TM SInterface and Bar code function keysre-categorized

Autofire, TMS Interface and Barcode function keys can now be found under the following command categoriesin the Edit
Command dialog window:

Command Category Function Key

Check Begin Pickup Begin Autofire Check
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Menu ltem Barcode Entry

TMS Interface TMS Interface Clean Table
TMS Interface Clear Table
TMS Interface Close Table

TMS Interface Transfer table

63774

Support for Bluetooth printing from mTablet E Series devices has been introduced

mTablet E Series workstations support Epson TM-P60 and TM-P60II Bluetooth printers. Configuration of Bluetooth
printers remains the same as outlined in the Bluetooth Printing article.

For sitesthat are utilizing mTablet E Series devices, currently there is a one-to-one relationship between a tablet and a Bluetooth
printer. In other words, once a Bluetooth printer isidentified and configured in the EMC as being paired with a specific mTablet
E Series workstation as the Print Controller Service Host, no other mTablet workstation or MMH can have that same Bluetooth
printer assigned to print its print jobs.

63990

Support to prevent assigning Menu Item Ranges with pre-existing menu item number s has been added

Simphony now shows an error message and prevents users from assigning menu item ranges that include pre-existing menu
item numbers within the Enterprise when assigning/editing Menu Item Ranges in the Properties module. For example, if
Property ' A’ has menu items between the ranges of 800-1000 and a user attempts to assign the menu item range 700-900 to
Property ‘B’, since Property ‘A’ already has menu itemsin that range, the insertion is prevented.

The returned message shows the menu item number, name and location in the Enterprise where the menu item(s) already exists.
Y ou must either define a different range, or delete the interfering menu items.

(B T

The following record numbers slready exist in the given range
# Name Location -
905 "WHITE STAR Beach Hotel
50% *STEEL CHARD Beach Hotel
910 *HEITZ CHARD Beach Hotel
911 "=NAPA CHARD _Beach Hotel
512 | =SIMI S/BLANC _Beach Hotel
913 *FETZER CHARD Beach Hotel
914 *WHITE ZINFANDEL Beach Hotel
915 *BENZIGER CAB Beach Hotel
916 *KENWOOD CAB Beach Hotel
917 *KJ CHARD Beach Hotel
918 *K1 CAB Beach Hotel
919 DALE'S WINE Beach Hotel
1000 - Bottle Wine - Beach Hotel e
N

However, Simphony does allow you to assign a range where menu items in the defined range already exist at that Property. For
example, assigning the range 900-1010 for Property ‘A’ where menu item numbers 800-1000 aready exist is alowed.

35349

69570, 74397

Magnetic stripereader (M SR) configuration has been enhanced to support new M SRs.

With the support for multiple magnetic stripe reader devices, MSR configuration has been moved to Setup-> Setup tab->
Workstations-> Devices tab. From the devices tab, you can now enable the MagTek DynaPro and the MagTek uDynamo
Audio Jack Reader devices.
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Perpharal Device Configuration

Add Deate Edit

# | Type |

Device [ Configur ation |
(| 1 USH or Hustooth Mag Stripe Reader )

[MagTek EymaPro Reader | MAGTEX Dymapro

Consecutively, option bit behavior for options 55 and 57 has been changed. Option 55 and 57 are now located under the
Workstations-> Options tab-> Hardware/Cash Drawer tab and the option labels and context-sensitive help are now as follows:

55 - Enable Encrypted Magnetic Stripe Reader Support

Enable this option to use an encrypted MSR. During an upgrade the DynaPro device will be added to this workstation's
devicelist if Option 55 was checked prior to the upgrade. If this device is a MICROS wor kstation, the magnetic card reader
in the workstation will have its encryption capabilities turned on when checked. Refer to the individual workstation model
documentation to ensure your internal reader is capable of encryption. The credit card entry field which is displayed in
OPSwill be secured and no longer allow numeric entry to ensure data encryption. NOTE: Once this option is enabled, it
cannot be turned off. Before enabling this option, ensure that the credit card processor/gateway is capable of supporting
the encryption functionality.

57 - Only use DynaPro as credit card reader
Enabling this option bit will cause the workstation to only allow credit card swipes to occur on a DynaPro reader and the
internal reader will no longer be usable for credit card swipes. Any card data processed through the internal reader which
appearsto be credit card data will not be accepted. NOTE: If this option bit is enabled and there is either no reader
configured in the workstation's device table or the reader is not attached to the workstation, it will not be possible to
process credit cards through this workstation.

Troubleshooting Tip: If you attempt to authorize a credit card and the MagTek M SR device is disconnected, you will see the
below message:

Missing or Error connecting Encrypted payment device.

To usetheinternal MSR, press the credit card authorize key once again. A prompt will appear to swipe the credit/debit card.

Enter Credit/Debit Card Information

L

Ok Cancel

Install

69367

CAL v128A hasbeen added to the Simphony installation package to standardize the supported version of CAL for all
clients

With this release, the installation of the Simphony software includes the installation of CAL v128A for all device CAL
packages.

iPad
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62833

PagesT oL oad setting deprecated from iPad 4 and iPad Air devices

With this release, PagesTolL oad is no longer supported. Users now have accessto al pages on iPad 4 and iPad Air devices.

35297

66219

PMC Taskstab has been replaced by a Jobstab on iOS devices

The Tasks tab which generally appears under the State column has been replaced by a Jobs tab in iPad mini and iPad 2
devices asiOS users do not require this functionality.

mymicr os.net

75321

A new version of mymicros.net has been incor porated into Simphony v2.7 installation

The installation mediafor Simphony v2.7 now includes the latest version of mymicros.net,mymicros.net v8.4.0.

Ops

19233

A Start of Day (SOD) function for a Property that can beinitiated from a Workstation has been introduced

Privileged users can initiate a Property level SOD from a Workstation using a function that can be added on akey on a
touchscreen. Prior to using the [Start of Day] function, the Property must be configured to run its SOD manually. See the
Configuring a Property level Start of Day 2.x and Start of Day articles for more information.

43012

Support to reject Unit of Measure (UOM) mismatch between Ops and scale has been added

With this release, Simphony has been enhanced to provide the ability to reject the UOM of a Weighed Menu Item when
posting it to atransaction, if the UOM sent by the scale differs from the UOM defined in the EMC viathe EMC-> Property
Level-> Setup tab-> Parameters-> Property Parameters-> Options tab.

Previoudly, if aUOM mismatch occurred, Simphony converted the value sent by the scale to the EMC defined UOM. Now, users
have the option of choosing whether to convert, or to reject the mismatch in such instances. A new option, [13 - Convert Weight
to System Unit of Measur €] has been added to the EMC-> <Enterprise/ Property / Revenue Center>-> Setup tab-
>Parameters-> Control Parameters-> Options tab.

When enabled, the UOM received by the scale will be converted to the UOM defined by the system. When disabled, if the UOM
received from the scale differs from the UOM defined in the system, the following error message will be displayed:

Unit of Measurement mismatch is detected. Scale weight unit configured in EMC must be <UOM>
The context-sensitive help (CSH) text for option [13 - Convert Weight to System Unit of M easur €] reads as follows:

If set, if the Unit of Measure (UOM) received from a scale does not correspond to the UOM established by the systemin
Property Parameters Options, the system will convert the weight to the Property’s UOM. For example, if the scale sends 8
ounces as the weight and the system is configured to use pounds, Ops will record the Item as .5 pounds. If not set, if a UOM
mismatch is detected, Ops will disallow posting of the Weighed Item and return a message indicating that the UOM's are
not in agreement. This option must be set off in the USto comply with Weights and Measures requirements.

50700

Additional page margin configuration for the banquet guest check printing module has been added
With this release, users can set margins for additional banquet guest check pages.
To set page margins for additional banquet guest check pages, follow these steps:
1. Navigate to the EMC-> Property level-> Setup-> Hardware/Interfaces-> Printers-> Printers.

2. Select the banquet guest check printer.
3. Enter the values for the Top, Bottom, and L eft under the Other Page Margins section.
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Current Record

Number I“ Pusit This Record

Mame |Banguet Guest Check Printer

Print Controfler and Printer Type
Workstation Il - Coffee Shop

Printer Type |CL.5tun| Page Prirter

RAJET

Printer Options

[ Multi-lingual-card is installed
["] Thermal printer

[ Guebec SEM Device

[] Print in Low Resolution

Printer Configuration
Address |192.168.40 242

Port |31D‘J Default |
First Page Margins Other Page Margins:
Top [0.00 Top [0.00
Bottom |0.00 Bottom I[}E'I]i
et o0 Left [go0
4. Click Save.
61356 Dependency of Condiment Discountability on option [30 - Selected menu item to include parent menu item in discount] has
been removed
With thisrelease, it is no longer mandatory to enable the Discounts option [30 - Selected menu item to include parent
menu item in discount] when using the Condiment Discountability methods, 0-Use M| Class option, 3-Parent and
Highlighted Condiment Items, and 4-Parent and All Condiment items. Discount are now applied to the parent menu item
even when the child item is selected in the check detail area regardless of whether option [30 - Selected menu item to
include parent menu item in discount] is enabled or disabled when using Condiment Discountability methods 0,3 or 4.
62151 mTablet E Series devices automatically lock in Landscape page orientation when Opsisup and running
By default, when Opsis maximized and actively being used, the touchscreen islocked on Landscape orientation. When
privileged users close or minimize Ops on the tablets, they can unlock the Landscape orientation and when the tablet is
rotated, it resumes its automatic adjustment to either Portrait or Landscape page orientation.
PMC Procedures
60104 User Interface (Ul) has been enhanced for Edit Menu Item Availability and Redirect Order Devices procedures
Two Uls now exist for each procedure: legacy and new. The new Ul is enabled if:
= Theworkstation is running POSReady or Windows 8 (not Win32)
= The Enable Engage option is set on the workstation
If the web.config.txt "EngageSimulated" setting is False, the system will attempt to load the Engage DLLSs. If thisfails, the legacy
screens will appear. If the "EngageSimulated” setting is True, the new screens will appear.
In addition, the new Ul for Redirect Order Device is now afull page.
The functionality of the Edit Menu Item Availability and Redirect Order Devices procedures have not changed.
Printing
43364 Support to separate service char ges as fees and tips on Banquet Guest Check format two and three has been added

Y ou can now print service charges received as tips and fees separately on Banquet Guest Check format two and three. Two
new options have been added to the Service Charges module to define service charges as tips or fees. The options and their
context sensitive help (CSH) texts are as follows:

26 - Configure as Banquet Tip

When this option is enabled, the amount of the Service Charge transaction will be included in the "Tip" line item of the
Banquet Check.

27 - Configure as Banquet Fee

When this option is enabled, the amount of the Service Charge transaction will be included into a"Fees" line item based
upon the selected Service Charge on the Banquet Check.

Once the service charges are defined as either tips or fees, the following additional information is printed on the Banquet Guest
Check format two and three:
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= Tip - Sum of service charges received astips
= Additional Tip - Sum of service charges not configured as either atip or fee
= Banquet Fees— Lists all service charges received as fees
Todefineaservicechargeasatip or fee
1. Navigate to the EMC-> <Enterprise/ Property>-> Configuration tab-> Sales-> Service Charges
2. Click thel=I icon under the Options column of the respective service charge.
3. If the service chargeis atip, select [26 - Configure as Banquet Tip].
If the service charge is afee, select [27 - Configure as Banquet Fee].
4. Click Save.
Reports
28070 Simphony now supports multi-language translation for mymicros.net reports
With this release, Simphonysupports multi-language translation for mymicros.net reports. A new option, [17 - Send
selected translationsto Simphony Reports] and a new check box named Send Translationsfor thisLanguageto
SimphonyReports have been introduced to transfer language text from Simphonyto mymicros.net. The context-sensitive
help (CSH) text for these interface elements read as follows:
= [17 - Send selected translationsto Simphony Reports)
Enable this bit to cause definition translations to be sent to Smphony Reports. The “ Send Trandlations for this Language to
Smphony Reports’ in the Language module must also be enabled for each language to be sent over to Smphony reports.
= Send Trandationsfor thisLanguage to SimphonyReports
Enable this bit to cause translated definitions for this language to be sent to Smphony Reports. The “ Send Selected
Translations to Smphony Reports’ option in Enterprise Parameters must be enabled as well.
Enterprise Parameters option [17 - Send selected trandationsto Simphony Reports] must be enabled to make Send
Trandationsfor thisLanguage to Simphony Reports available. When both these options are enabled, al translations donein
the EMC (menu items, definitions etc.) are transferred to mymicros.net.
Totransfer language text from Simphony to mymicros.net,
1. Navigate to the EMC-> Enterprise level-> Setup-> Parameters-> mymicros.net tab-> Options.
2. Enable[17 - Send selected translationsto Simphony Reports].
3. Click Save.
4. Navigate to the EMC-> Enterprise level-> Setup->Enterprise Configuration-> Languages-> Miscellaneous tab.
5. Enable Send Trandationsfor thisLanguageto Simphony Reports.
6. Click Save.
SIM
74172 Ability to call elements of the guest check separately has been added
The following SIM properties are now available in @OpsContext and gives you the ability to select individual elements of
the guest check such as the header, trailer, etc.:
= CheckHeaderLines - Returns the standard check header lines
= CheckTrailerLines — Returns the standard check trailer lines
= CheckTableAndGroupText — Returns the Check Table Text and Group. If the field is not blank and a table number is used,
the table number/group is returned. If the field is not blank and atable name is used, the table name/group is returned.
» |sFastTransaction - Returns Trueiif it is afast transaction check. Returns Falseiif it is a guest check
This enables you to apply special print commands such as double-wide printing, print in red, etc. to each element viathe SIM print
command.
Transaction Services
73952 Transaction services now allows a chargetip to be applied to a tender using cash payments
Customers can now place charged tips using cash (non-charge) payments through transaction services.
Revisions
FixID | Revision | cr#
Credit Card Batch Process
53185 “ Issue: Duplicate batch numbers caused Property Credit Card Batches to incompletely settle if an RV C exceeded the ‘Max Batch | 35012
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Record’ limit
Resolution: The Credit Card Batch Process no longer uses pre-assigned batch numbers. Previously, when the Property level Credit Card
Max Batch Record field was configured, and one of the RVC's Credit Card transactions exceeded the defined Max Batch
Record limit, all successive settlements of the other RV Csfailed.
Credit Card Driver
54592 Issue:  The Cardholder's Name did not print on Credit Card V ouchers when swiped on ID Tech Internal and External Magnetic Stripe
Readers (M SR) with option [55 - Enable the Encrypted M SR] enabled
Resolution: The Cardholder's Name now prints on Credit Card Vouchers, and also in the Journals, when acard is swiped on ID Tech
Internal and External MSRs. Previously, the Cardholder's Name did not print when Tender/Media option [60 - Do Not Retain
Cardholder's Name] was disabled, and Workstations option [55 - Enable the Encrypted M SR] was enabled.
Database
22948 Issue: Workstations with large workstation object numbers configured to output to Kitchen Display Systems (KDS) prevented users 33675
from beginning checks
Resolution: The allowed maximum number of digitsin the Record number or range field has been reduced to 8 digits. If auser entersa
value over 8 digits, or entersthe value in the incorrect format, the EM C shows an error message.
71650 Issue:  Upgrading Simphony 2.5 to Simphony 2.6 cleared the backup device records from the order devices module 35596
Resolution: Upgrading Simphony 2.5 to Simphony2.6 no longer clears the backup device records from the order devices module.
Data Transfer Service
75350 Issue:  Unposted journals prevented other journals from posting to mymicros.net 35726
Resolution: The Data Transfer Service (DTS) has been fixed and no longer allows unposted journals to prevent the posting of other journals.
Direct Posting Service
47733 Issue:  Direct Posting Service (DPS) did not post the menu item level tax totals to the GUEST_CHECK_LINE_ITEM tablein the 34967
location activity database
Resolution: Menu item level tax totals are now posted to the GUEST_CHECK_LINE_ITEM table in the location activity database.
70055, Issue:  Direct Posting Service (DPS) threw an error in the DPS log and check details were not posted to mymicros.net
=2 Resolution: Check details are now posted to mymicros.net. DPS no longer throw the below error in the DPS log.
Error: The parameterized query '(@organizationl D bigint@locationl D bigint@revenueCenter 1D bigi'
expectsthe parameter '@cashier| D' ::which was not supplied.
Statement(s) could not be prepared.
Thisfix has been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
EMC
4135 Issue:  Remote distributing page design records caused data format or communication errors 30700
Resolution: Remote distributing page design records no longer display error messages.
10523 Issue:  Enabling RV C Parameters option [23 - Retain Current Main Level after a Transaction] and [24 - Retain Current Sub
Level after a Transaction] did not retain current Main/Sub Menu level
Resolution: Theoptions, [23 - Retain Current Main Level after a Transaction] and [24 - Retain Current Sub Level after a
Transaction] now function as expected. Previously, when either option was enabled, the workstation reverted back to the
default Main/Sub Menu Level when the operator signed back in to the workstation.
23138, Issue:  Simphony returned an error when users with property-level visibility attempted to log in to the EMC 35583,35609
71973 Resolution:  Users with property-level visibility can now successfully log in to EMC without an error. Previously, deleting a property that
was included in azone configuration resulted in an orphaned record that caused the EMC to display asign in error for users
without enterprise-level visibility.
40104 Issue: Several Hardware/Interfaces modul es showed object reference errors when users attempted to save an update
Resolution:  Users can now successfully save updated records in the Payment Drivers, Payment Device, Loyalty Driver and Stored Value
Driver modules without an error.
48362 Issue:  Workstation date selection dialog was too small
Resolution: Workstations now display the date selection dialog as follows:
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54399 Issue: A check created with zero or negative totals increased the guest and guest check counts in mymicros.net reports 35121
Resolution: Checks created with zero or negative transactions are no longer added to Checks/Avg Spend and Table Turns/Avg Spend counts
in mymicros.net reports. Previously, when the RV C Parameters [5 — Zero or Negative Transactions Do Not Add to Guest or
Guest Check Counts] was enabled, zero or negative transactions increased the guest and guest check counts in mymicros.net
reports.
55219 Issue:  Content could be saved without configuring any prompt
Resolution: Userswill now get an error message if they try to save the configuration settings on the Configure Content Prompt screen
without configuring a prompt.
55330 Issue: InForm View, when aworkstation record was modified and the changes were saved while being active on another record, the
active workstation was renamed to that of the modified workstation
Resolution: The EMC Workstation module no longer duplicates the workstation names.
62848, Issue: Tranglated legends of page design buttons were copied as " ??7??"
64770 Resolution: Copying a button with atranslated legend now correctly copies the legend value. Previously, when a button with a translated
legend was copied and pasted, the translated legend was copied as “ ????". Thisfix has been applied to both Simphony v2.6
Maintenance Release 2 and Simphony v2.7 GR.
63149 Issue:  In Module Reference Report ->Text View, menu item location path entries that exceeded 35 characters were truncated 35313
Resolution: On the Text View tab of the Module Reference Report, the text for menu item location path entries that exceed 35 characters
now word wrap instead of being truncated.
63522 Issue:  Users could not navigate to the last employee record in Form View of Employee Maintenance 35319
Resolution:  Users who select the Next Record button on the EMC toolbar or use Alt +Right Arrow keys can now navigate to the last
employee in the Form View results list in the Employee Maintenance module. Previously, users had to select the last employee
record in Table View to enter Form View.
65224 Issue:  Users could not open the TM'S Parameters module after upgrading from 2.5 35386
Resolution:  Users can now open the TM S Parameters module from all levels within the EMC after upgrading to Simphony 2.7 from
Simphony 2.5 or later. Previously, users who had configured the Loyalty module in Simphony 2.5 and then upgraded to
Simphony 2.6, would get an error message when they tried to open the TM S Parameters module.
66556 Issue: The context-sensitive help (CSH) text for Enterprise Parameters option [16 - Enable Secured Connection] has been updated
Resolution: The CSH text now reads as follows:
When enabled, all data transmission between EMC and the Server will be encrypted for all users. Enabling secured
connection will increase the size of data that is exchanged and in doing so, increase the amount of time required to
communicate and process these messages. When disabled, response messages from the server are not encrypted with the
exception of Employee related data. If this option is changed, the user must disconnect before the change will occur.
66681, Issue:  Add Property dialog did not indicate the modules enabled by default under the “Modules to Copy” section and when cloned, 35418
71171 individually selected modules were not copied.
Resolution: Add Property dialog now indicates the modules enabled by default. When cloned, individually selected modules are now
copied. Thisfix has been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
68617,71174 Issue:  The Simphonysystem was placed in Demo Mode if the EGateway licensing check failed at initialization 35549
Resolution: Now, if the EGateway licensing check at initialization fails to connect to the database, the Direct Posting Service (DPS) checks
the license status every 5 minutes until it can be authorized without placing the system in Demo Mode.This fix has been applied
to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
70470 Issue:  Menu item (MI) definition distribution was slow
Resolution: The menu item definition distribution process is now more efficient with enhanced batching. Previoudly, only one request was
sent per each menu item definition.
72624 Issue:  Simphony installation prompted usersto install .NET Framework 4.5 manually when upgrading to Simphony 2.7
Resolution: Before upgrading to Simphony 2.7, please ensure that .NET Framework 4.5 isinstalled on the application server. A copy of
.NET Framework 4.5 can be found in the installation media package under Prerequisites\DotNetFramewor k45.
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73678 Issue:  Objects configured to have a Next Page/Panel moved slowly in Page Design 34982
Resolution:  Objects with a Next Page/Panel assigned now move smoothly in Page Design. Previously, when a Next Page/Panel was
assigned to an object, users experienced a delay when attempting to change its position.
73982 Issue: The context-sensitive help (CSH) and the label of format parameter [10 - Print Open and Closed Time on Check] did not
depict the correct behavior
Resolution: The CSH and the label of format parameter now depict the correct behavior. Previously, the CSH incorporated customer
receipts and the label did not mention the printing of date on the guest check. The CSH and the label have been revised as
follows:
[10 - Print Open and Closed Date/Time on Guest Check]
When enabled, this option will print the date and time the guest check was opened and closed. When disabled, this option
will only print the date and time closed on the guest check.
74790 Issue: RV C Configuration showed Data Extensions incorrectly 35710
Resolution: RV C Configuration has been fixed and now shows Data Extensions correctly. Previously, re-opening the RV C Configuration
modul e after saving text to the Data Extension did not show the saved data and each time the RV C Configuration module page
was refreshed, an extra column was added for the same Data Extension. Additionally, an error message was shown when users
attempted to enter data to the new duplicated Data Extension column.
74971 Issue:  Employee Maintenance would not save data entered to Information Lines 35712
Resolution: Employee Maintenance now saves data entered to the employee Information Lines.
75006 Issue: Workstation Autosequences module showed in Enterprise search despite being deprecated from Simphony v2.x
Resolution: The Workstation Autosequnces module no longer shows in the EMC search results.
75932 Issue:  Context sensitive help (CSH) text for Currency -> Number of Digits drop-down menu was incorrect
Resolution: The CSH text now reads as follows:
Select the number of digits after the decimal point that each currency allows.
Install
47058 Issue:  Remote distributing an extension application created a blank record in the destination enterprise and the workstation threw a
CLIENT ERROR
Resolution: Remote distributing an extension application no longer creates a blank record in the destination Enterprise and the workstations
no longer display a CLIENT ERROR at startup.
Kitchen Display System (KDS)
72770 Issue:  Workstations sent the fire on fly (FOF) and fire on next (FON) messages to kitchen display system (KDS) synchronously, 35657
causing delays in ringing up menu items
Resolution: Workstations now send the FOF and FON messages to the KDS asynchronously.
Ops
23625 Issue: Windows CE workstations displayed the “ Out of Memory Transaction Cancelled” error and the Workstation had to be 33747
restarted to continue operations.
Resolution:  Windows CE workstations no longer display the “ Out of Memory Transaction Cancelled” error. This has been corrected.
46819 Issue:  An error message was shown when a menu item was selected on the Split Check screen after removing an empty Split Check
Resolution:  Ops no longer shows an error message when a user selects (clicks/taps) amenu item on the Split Check screen after deleting an
empty Spit Check.
47965 Issue:  Pressing the [Combo Alter nate Side] function key did not display alternate menu item choices for a combo meal 34930
Resolution: The Condiment/Combo Orderer now shows alternate menu items for a combo meal when the [Combo Alternate Side] function
key is pressed.
48382 Issue:  The date selection dialog did not allow operators to select a backdate when beginning a Banquet Guest Check by prompt
Resolution: Operators can now select a backdate when beginning a Banquet Guest Check using the [Begin Check by Prompt] function key.
In addition, the date correctly appears on the Check Detail Areanow.
48745 Issue:  The check detail areawas not fully visible on MC-40 Mobile MICROS handheld devices
Resolution: The check detail areais now fully visible on MC-40 Mobile MICROS handheld devices. Previously, the check detail panel did
not scale to fit the screen.
48816 Issue: iCare did not take input from barcode scanners 34983
Resolution: iCareisnow fixed to handle barcode reading. Previously, barcode scanners failed when scanning an iCare account number. The
scanner beeped as expected but, did not display the account window.
49026 Issue:  Pressing the [Quebec SRM Control] function key did not invoke the dialog window to select assigned printers on Windows CE
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Workstations
Resolution: Windows CE Workstations now show the dialog window which enables operators to enable or disable printers.
52965 Issue:  The Ops onscreen keyboard did not recognize the shift key press from the attached keyboard
Resolution: Ops onscreen keyboard now recognizes the Shift key input from the physical keyboard attached to the workstation.
53270 Issue: Wait List and Reservation onscreen virtual keyboards did not have a button for the ‘ @' key
Resolution: An'@’ key button has been added to the Add Wait List Entry and Add Reservation Entry dialog onscreen virtual keyboards.
53736 Issue:  Workstation had to be restarted as the Database Update function did not update the Application Text changes made to the
Banquet Guest Check Printing
Resolution: Database Update function now updates the Application Text changes made to the Banquet Guest Check printing.
54890 Issue: Banquet Guest Checks did not print operator entered values if the Application Text was overridden
Resolution: Operator entered values now print on Banquet Guest Checks when Application Text is overridden. In addition, a new Prompt
Category drop-down menu has been added to the Configure Content Prompt dialog so users can specify the field to which the
prompt is being configured.
56682 Issue:  The table number of the split check was not shown on other workstations belonging to the same Revenue Center (RVC)
Resolution:  Windows 32 and Windows CE workstations now show the table number of split checks on al workstationsin aRVC.
Previously, when an operator split a check started using the [401 - Begin Check by Table] function key, only the workstation
that created the check showed the table number of the spit check on the Open Check SLU and the Pickup Check from List
dialog.
56695 Issue:  Team names with an apostrophe did not appear properly in the Team Service dialog
Resolution: Team names with apostrophes now appear correctly when creating Service Teams using the [Create Team Membersor Add
Team to Check] function key using an external keyboard at the workstation. Prior to thisfix, the apostrophe was replaced by
the character '& po' on the Team Service dialog.
63254 Issue:  Complex Workstation Revenue Center (RV C) configurations caused certain workstations to not receive open check information 35318
from the Check and Posting Service (CAPS)
Resolution:  All workstations in a property now receive open check information from CAPS. Currently, during the CAPS RV C Group
processing, an RVC Group is only eliminated if all its RV Cs appear in the superset RV C Group. Previously, an RV C Group
was eliminated if any of its RV Cs appeared in a superset RV C Group.
63525 Issue:  When thereis only one team, deleting a team using the Select All check box threw an exception error and the Ops stopped
responding
Resolution: The delete operation now completes successfully. Previously, deleting a single team using the Select All check box threw an
exception error and the Ops stopped responding.
65419, Issue: [Auto Block Check Transfer] only transferred the Checks belonging to the Workstation 35296
6269 Resolution: [Auto Block Check Transfer] function now transfers all the open Checks in the Revenue Center (RVC). Thisfix has been
applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
69361,71399 Issue:  When the RV C parameter [58 - Auto Combo Items On The Fly] was enabled, workstations had to be restarted as the 35415
[Database Update] did not reflect the Combo Mea Group modifications
Resolution: [Database Update] function now reflects the newly added Combo Meal Groups or modifications made to existing Combo Meal
Groups on workstations. This fix has been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
69562, Issue:  The tax and service charge amounts were incorrectly calculated when using Automatic Discounts 35462,
?ffgf ’ Resolution: Tax and service charge amounts are now calculated from the subtotal after Automatic Discounts are applied if options[3 - This 35508
71192‘ isan Item Discount] and [31 - Net Automatic Service Charge Itemizer] are enabled (in EMC-> <Enterprise/Property> ->
Configuration tab-> Sales-> Discounts-> General tab-> Options) for all Automatic Discounts and Discount rules. Thisfix has
been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
72183 Issue:  Manual subtotal discounts are no longer shown in the Touch Edit Seat screen
Resolution: Manual subtotal discounts are no longer shown in the Touch Edit Seat screen because the discount is applied to the entire check
and not to individual seats.
72392 Issue:  Freguent use of Next Page/Panel keys on WSEA clients displayed the Program Memory is L ow message
Resolution: Memory usage has been enhanced to release the memory used by the Next Page/Panel keys. If the issue persists, restart the
service host application.
73677 Issue:  Status bar elements, Transaction Cashier Name and Transaction Cashier Number, did not show after ServiceHost restart 35636
Resolution: Transaction Cashier Name and Transaction Cashier Number status bar elements now show the current information at all times.
Previoudly, the Transaction Cashier Name field did not populate, and the Transaction Cashier Number field showed the value
‘0’ on the status bar after a ServiceHost restart until an operator signed back in to the workstation.
73727 Issue:  The check detail areadid not show menu items scanned by barcode accurately 35614
Resolution: The check detail area now shows an entry for each menu item scanned by barcode. Previously, after a database download or a
database refresh, the check detail area only showed a single entry or no entry at all for items scanned by barcode. It did however
show the correct subtotal of the check.
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73867 Issue:  An empty message was shown at the workstation if posting to the PM S was denied 35670
Resolution: Ops now properly interprets and shows the correct PM S response. Previously, an empty white dialog window instead of the
actual message was shown at the workstation.
74042 Issue: The Ops consistently failed to display the Next Page/Panel screen assigned to a Menu Item Class
Resolution: If the Page Design module Visibility field is set to Thisitem is visible based on the following conditions: but no conditions
are added, Ops may fail to display the Next Page/Panel assigned to the Menu Item Class. Asaresult of thisfix, screen look-up
configuration panel option [Always Display Next Page Panel], which ignores the visibility conditions, was removed from the
EMC.
74223 Issue: Operators without the Role privilege [30050 - Run Diagnostics] could access PMC Device Diagnostics 35683
Resolution: The Device Diagnostics button is now hidden from the PMC Home Page Functions tab when the Role privilege [30050 - Run
Diagnostics]is disabled.
74599 Issue:  The check detail areaindicated repeatable items with an asterisk (*) instead of the lesser-than mark (<) when consolidated
Resolution:  With this release, repeatable menu items are no longer consolidated.
74663 Issue: When the [9 - Charged Tip Required] option was enabled for a charge tender, users could overtender a charge tender without a
chargetip link
Resolution: Now, when the[9 - Charged Tip Required] option is enabled and you attempt to overtender a charge tender without a charge
tip link, you will receive the following message.
Default Charge Tip Not Found
If you attempt to overtender a charge tender when a service charge not configured as a charge tip is linked to the charge tender,
you will receive the following message.
Invalid chargetip link.
This fix was applied to both Ops and Transaction Services interface.
74970 Issue: Direct entry of acharged tip caused the Transaction Shield (TVS) driver to report the charge tip total incorrectly and offline 15923358,
transactions charged twice the tip amount 15209678
Resolution: TVSdriver now posts the correct charge tip total when a charged tip is applied viadirect entry and offline transactions charge
the correct tip amount.
74974 Issue:  Opsdid not relinquish control when cancelling out of Loyalty for Load Configuration function
Resolution: The Load Configuration function has been removed from the Loyalty Operation Selection list in the EMC Page Design module.
If an operator has placed this button on a page in a previous Simphony version, a"Function not implemented yet" error will
appear when it is pressed.
75758 Issue:  When an employee was put in training mode on aworkstation using the [Edit Employee Training Status] function key, only 35627
that workstation reflected the change
Resolution: All workstations at a revenue center now receive changes to the employee training status through the workstation notification
update. Previously, other workstations at the revenue center would not acknowledge the employee’ s training status until alocal
database reload was performed on each workstation using the [Reload Workstation Database] function key.
75760 Issue: Coin dispenser stopped working intermittently 35655
Resolution:  Thisissue has been corrected.
OPOS
70057, Issue:  UPOS Cash Drawer threw an exception error during initialization
71404 Resolution: The UPOS Cash Drawer no longer throws an exception error when verifying whether the UPOS device driver is closed during
initialization. Thisfix has been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
PM C Reports
9324 Issue:  Windows CE workstations did not completely translate workstation Reports to the Arabic language 32179
Resolution:  Windows CE workstations do not support the Arabic language due to Microsoft Silverlight restrictions.
42357 Issue:  The context-sensitive help (CSH) text for Role option [31111 - Do Not Run with Open Checksfor Any Report] needed 34754
clarification
Resolution: The CSH text for Role option [31111 - Do Not Run with Open Checksfor Any Report] has been revised as followsto clearly
state that this function is applied to the entire Property.
Select this option to not allow employees associated with this Role to run any report when there are open checksin this
property. Only Employee Open Check report can run in order to view open checks.
74281 Issue: Workstation Employee Tip Track Report did not have a Total Tips % line and showed the Total Tips line positioned incorrectly 35690
Resolution: The workstation Tip Track Report has been fixed and now shows the Total Tips and the Total Tips % lines at the end of the
receipt.
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PMS
67518, Issue:  Serial PMS communication did not honor X ON/XOFF messages 35427
s Resolution:  Serial PM'S communication now honors XON/X OFF messages. Previously, XOFF only had a single thread for carrying out
read/write tasks. Now, thisis done by two separate threads. This fix has been applied to both Simphony v2.6 Maintenance
Release 2 and Simphony v2.7 GR.
Printing
68520, Issue:  Reprint closed check functions recalculated the overtendered checks with tax exemptions 35439
71130 Resolution: Exempted tax rates no longer recalculate when [Reprint Closed Check] or the [Reprint Previous Closed Check] functions are
used on an overtendered Check with tax exemptions. Now, the original check appears in the check detail area. This fix has been
applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
69525,71403 Issue: Tax Exemption total was printed as $0.00 when Tax Parameters option [4 - Enable Canadian GST] was enabled 35430
Resolution: The Tax Exemption total is now accurately printed on customer recei pts and guest checks when option [4 - Enable Canadian
GST] isenabled and al active tax rates are exempted from a check. Thisfix has been applied to both Simphony v2.6
Maintenance Release 2 and Simphony v2.7 GR.
Reports
57294 Issue:  Windows CE Workstations crashed when attempting to customize workstation reports
Resolution: Windows CE workstations no longer crash when users attempt to customize the workstation reports. Previously, the workstation
crashed if the operator pressed any of the available drop-down menus corresponding to the selected report.
63544 Issue:  Blind Drop Tenders were being displayed in Bank Due section of Financial Reports 35322
Resolution: Financial Reports have been fixed to not show the Blind Drop Tenders in the Bank Due section when option [31112 - Do Not
Show Blind Drop Tender Groups] is enabled.
65036 Issue:  Shifts defaulted to O instead of 1 when shifts tracking was initially enabled 35331
Resolution: Employees and cashiers are now defaulted to shift 1, when shift tracking isinitially enabled. Previously, when shift tracking was
initially enabled, the shift was defaulted to Shift 0 instead of Shift 1. Also, when the employee/cashier shift was incremented for
the first time, the employee/cashier financial reports incorrectly showed that the shift had been incremented from shift O to shift
2.
69353,71398 Issue:  RVC Parameter [7 - Post Tender (only) to Transaction Operator] did not work when a check was tendered with currency
conversion
Resolution: Tendering a check using currency conversion now posts the tender totals to the transaction operator as expected by the RVC
parameter. Thisfix has been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.
72516 Issue:  When the transaction operator had zero net sales, transaction operator’ s shift was not reset to shift 1 at the Start of Day (SOD) 35587
Resolution: Transaction operator’s shift is now reset to shift 1 at the SOD. Previoudly, when the RV C Parameters [Do not reset Employee
Financial Shiftswith the start of each business day] was disabled, only the check operator’s shift was reset to shift 1 and the
transaction operator’ s shift was not reset to one at the SOD.
74618 Issue:  When an open check was service totaled after the start of day (SOD), property financia report posted values to the Carried Over
and Outstanding totals for the previous business day
Resolution: When an open check is service totaled after the SOD, check totals are now posted to the Begun and Paid totals for the current
business day.
75148 Issue: Employee Tip Report did not reflect changes made by the Edit Employee and Edit Tip Amount operations
Resolution: Employee Tip Report now displays the changes made by Edit Employee and Edit Tip Amount operations.
75186 Issue:  Employee shifts did not reset to shift 1 until after midnight 35715
Resolution: Employee shifts have been fixed and now resets to shift 1 after Start of Day (SOD). Previously, regardless of the SOD settings,
employee shifts only reset to shift 1 after midnight.
SIM
70092 Issue: When acharge tip was manually applied, prorating sales itemizers caused a negative total 35529
Resolution: Prorating sales itemizers no longer cause a negative total when a charge tip is manually applied.
74172 Issue:  SIM Variables @dwon and @dwoff were not performing as expected
Resolution: Double-wide printing can now be controlled on aline by line basis with the use of @dwon and @dwoff SIM Variables.
Previously, when these variables were utilized, the print task continued to print in double-wide text despite having the @dwoff
variable included in the script.
Stored Value Card
63292 Issue: Loyalty points were not added to guest checks once they were issued to aloyalty card
Resolution: Loyalty points are now correctly reflected on the loyalty accounts. Previously, when points were issued to aloyalty account, the
Check Detail Area showed the correct point amount, however, the loyalty account did not reflect the correct balance.
69527, Issue:  Service Totalling an Open Check after the Start of Day (SOD) posted the totals to the previous day’ s shift number 35451
AL Resolution: Check totals are now posted to the current day's shift number when Service Totalled after the Start of Day.
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Simphony 2.7 - Wiki

Disabling the RV C Parameters [Do not reset Cashier Financial Shiftswith the start of each business day] and [Do not
L "= reset Employee Financial Shiftswith the start of each business day] resets the Financial Shifts with the start of a new
business day.

Thisfix has been applied to both Simphony v2.6 Maintenance Release 2 and Simphony v2.7 GR.

Transaction Services

63287 Issue: Transaction Services (POS API) client open check list showed incorrect values for Check Order Type and Autofire Firetime
values
Resolution:  Transaction Services client open check list now shows correct information for Check Order Type and Autofire Firetime
values.
75726 Issue:  Whenthe[9 - Charged Tip Required] option was enabled, users could overtender a charge tender without a charge tip link
using the [Auth and Pay] key
Resolution:

Now, when the [9 - Charged Tip Required] option is enabled and you attempt to overtender a charge tender without a charge
tip link using the [Auth and Pay] key, you will receive the following message.

Invalid chargetip link.

If you attempt to overtender a charge tender when a service charge not configured as acharge tip is linked to the charge tender,
you will receive the following message.

Invalid Service Chargetip link.
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